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1 PREFACE 

The Bruker Compass ReportDesigner 4.5 application (referred to as ‘ReportDesigner’) 
is the state-of-art Windows XP application for designing report layouts for printing 
reports with Bruker Daltonics programs.  

The ReportDesigner can be used to modify existing or to create own report layouts. A 
rich palette of graphical elements and dedicated, application specific components are 
available to be included in a layout, e.g., acquisition parameters or the chromatogram 
window. The ReportDesigner designs a layout by placing such components on a sheet. 
Layouts are used as a template when printing a report. A layout can only print graphics 
and results from one application. 
 
The ReportDesigner User Manual describes how to work with ReportDesigner 4.5. For 
reference on ReportDesigner 4.5 menus and commands, please refer to the Report-
Designer Reference Manual that is available as PDF document with your installation. 
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2 GETTING STARTED 

2.1 Installing and Uninstalling ReportDesigner 

The ReportDesigner 4.5 application installs automatically when a Bruker Daltonics soft-
ware package that includes this application is installed on your system.  

The ReportDesigner application is automatically uninstalled when this software pack-
age is uninstalled from your system. 

 

2.2 Running ReportDesigner in Compliance or Non-
Compliance Mode 

ReportDesigner can be operated in ‘Compliance’ or ‘Non-Compliance’ mode. Working 
in Compliance mode can support you to meet FDA 21 CFR Part 11 (FDA’s rule on 
electronic signatures and records) requirements. To run ReportDesigner in Compliance 
mode, the Bruker Daltonics Compass Security Pack program providing Bruker Dalton-
ics UserManagement needs to be installed either on this computer or preferably on a 
central server. When the ‘Compass Security Pack’ license is present, ReportDesigner 
is running in Compliance mode automatically. Otherwise, ReportDesigner is running in 
Non-Compliance mode. 

Note: Compliance mode in the context of Compass Security Pack exclusively means 
the availability of Compass Security Pack tools and functionalities, which can be 
used to support the user to meet 21 CFR Part 11 requirements. Neither Com-
pliance mode nor Compass Security Pack can assure full compliance with 21 
CFR Part 11 requirements. 

Compliance mode 
The Compliance mode offers the following features for ReportDesigner: 
• Only operators created by the customer’s UserManagement administrator can log 

into ReportDesigner after identification by operator ID and password. 
• The UserManagement administrator can administer access to ReportDesigner by 

assigning individual rights to the operators he creates. These rights concern the 
actions the operator is allowed to perform in ReportDesigner. 

• All Bruker Daltonics applications that are installed on the operator’s computer can be 
locked and unlocked by the operator. 
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Note: The features above apply to any application supported by the Bruker Daltonics 
UserManagement. 

Non-Compliance mode 
When ReportDesigner is running in Non-Compliance mode: 
• Anybody can log into ReportDesigner; no identification by operator ID and password 

is needed. 
• Operators having different ReportDesigner rights do not exist. 
• ReportDesigner and other Bruker Daltonics applications cannot be locked. 
 

2.2.1 Bruker Daltonics UserManagement 

When ReportDesigner is running in Compliance mode ReportDesigner uses the Bruker 
Daltonics UserManagement application.  

UserManagement enables you to administer access to Bruker Daltonics applications 
and manage individual action rights based on operator ID and password. Creating 
operators and assigning rights to them is performed using the Bruker Daltonics User-
Management Administration Tool application. Only the customer’s UserManagement 
default administrator and perhaps further UserManagement administrators (if having 
the ‘UserManagement Administration Tool: Administrate Operators’ right) have the right 
to create operators which should use ReportDesigner and assign individual rights to 
them concerning the actions these operators are allowed to perform in ReportDesigner.  

Before anybody apart from the UserManagement default administrator can log into 
ReportDesigner when in Compliance mode, the UserManagement administrator has to 
create (an) desired operator(s) specified by operator ID and password. To become 
effective an operator must be assigned to an operator group having specific rights 
included. The UserManagement administrator can use the auto-generated operator 
groups or he can define new groups to customize right assignments according to his 
own requirements. Also, the UserManagement administrator can modify the default 
password policy and timeout settings as desired. 

Note: For detailed information on how to create operators and assign rights, please 
refer to the UserManagement help tools. 

UserManagement is client-server based. On the server PC the database defining 
operators and their rights is installed, on the client PC the Bruker Daltonics applications 
are installed. 
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2.2.1.1 ReportDesigner Operating Rights in UserManagement 

In UserManagement specific rights for performing actions in ReportDesigner exist 
which can be assigned to an operator group and, therefore, to an operator. If an 
operator wants to perform an action without having the respective right, corresponding 
information will appear. 

The rights existing in ReportDesigner are listed below (in alphabetical order). The 
Open layouts right is the lowest right somebody must have to view data with Report-
Designer. 

Right: Allows performing actions concerning the following 
subjects:  

• Open layouts Opening layouts. 
• Modify/Save layouts Creating, modifying and saving layouts. 
 

2.2.1.2 Auto-generated Operator Groups and Their Right Assignments 
in ReportDesigner 

In UserManagement various so-called auto-generated operator groups are predefined 
with each of them having specific rights for performing actions in ReportDesigner 
included. The UserManagement administrator can assign a new operator to one of 
these auto-generated groups if he does not want to define own groups but he cannot 
change the right assignment of the predefined groups.  
The following operator groups are predefined in UserManagement (in alphabetical 
order): 
• Administrators (auto-generated) 
• Operators (auto-generated) 
• Project Managers (auto-generated) 
• Scientists (auto-generated) 
• Service (auto-generated) 

Which ReportDesigner rights are assigned to the auto-generated operator groups is 
shown below (the figures show the respective sections in the UserManagement Admi-
nistration Tool). No differences exist between an operator of the ‘Administrators (auto-
generated)’ and the ‘Project Managers (auto-generated)’ group; both have all rights 
that are available for this application. An operator of the ‘Scientists (auto-generated)’ 
group is lacking the Modify/Save layouts right whereas an operator of the ‘Operators 
(auto-generated)’ group has no rights in ReportDesigner. The ‘Service (auto-gener-
ated)’ group is used for service purposes of the manufacturer. 
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‘Administrator’ ‘Project Manager’  

    
‘Scientist’ ‘Operator’ 

    
Figure 2-1 ReportDesigner rights assignments of the predefined operator groups 
 

2.3 Starting ReportDesigner 

You can start ReportDesigner from the Windows Start menu. During installation of the 
Bruker Daltonics software package, a Bruker Daltonics folder was created automati-
cally in the Start menu’s Programs folder. This contains the respective applications. 
You can also start ReportDesigner via Windows Explorer by double-clicking an existing 
layout file (*.layout) that automatically starts ReportDesigner and opens the respective 
report layout. 

On starting ReportDesigner, a dialog appears that requests you to log in unless you are 
currently logged in another Bruker Daltonics application (for Compliance as well as 
Non-Compliance mode) or the corresponding option for skipping this dialog is set (for 
Non-Compliance mode only). 

After log in is performed, ReportDesigner starts with automatically opening an empty 
layout named 'Report 1' when started via Windows Start menu or the selected layout 
when started via Windows Explorer. 

To start ReportDesigner via the Windows Start menu: 

1. Click . 
2. Click Programs. 
3. Click Bruker Daltonics. 
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4. Click ReportDesigner. This starts ReportDesigner and opens the Report-
Designer dialog. 

  
5. Log in if requested. 

To start ReportDesigner via Windows Explorer with opening the selected report 
layout: 
1. Start Windows Explorer. 
2. Navigate to the layout file you want to open: 
3. Double-click the layout file. This starts ReportDesigner and opens the Report-

Designer dialog. 
4. Log in if requested. 
 

2.4 Logging an Operator into ReportDesigner 

When ReportDesigner is running in Compliance mode, only operators created by the 
UserManagement administrator can to log into ReportDesigner after identification by 
operator ID and password. Multiple successive wrong logons will cause locking of the 
operator. The UserManagement administrator defines the maximum number of false 
attempts allowed. 

When ReportDesigner is running in Non-Compliance mode, any operator can log in 
after entering an operator ID. Identification by password is not required.  

Note: Only one operator can be logged into Bruker Daltonics applications on a speci-
fic computer at a time. 

Logging in must be performed after starting ReportDesigner unless you are currently 
logged in another Bruker Daltonics application (for both Non-Compliance and Com-
pliance mode). When ReportDesigner is running in Non-Compliance mode an option 
for automatic log in of the specified operator can be set. 



Getting Started Bruker Daltonik GmbH 

 ReportDesigner User Manual, Version 4.5 2-6 

If, when in Compliance mode, ReportDesigner is the first Bruker Daltonics application 
into which you want to log after the UserManagement administrator has defined you as 
a new operator, the program will require you to change your password. 

To log into ReportDesigner: 
1. Start ReportDesigner or when in a running session select Operator from the Help 

menu. This opens the ReportDesigner dialog that corresponds to the mode in 
which ReportDesigner is currently running.  

2. In Operator, enter your operator ID. The operator ID is not case-sensitive. 
3. When in Non-Compliance mode, check Always log in using this operator if you 

want the specified Operator to be logged in the next time automatically without 
showing the log on dialog again. 

4. When in Compliance mode, enter your password in Password.  
Note: Passwords are case-sensitive. Be careful, too many successive wrong 

inputs will cause locking. 
5. Click Log On. In Compliance mode, log in will be successful only if operator ID and 

password match. 
6. If you are required to change your password, change it and repeat steps 4 and 5. 
 

2.5 Changing the Operator's Password 

When ReportDesigner is running in Compliance mode, the operator who wants to log in 
has to identify by password.  

The program will require you to change your password when you log into a Bruker 
Daltonics application supporting UserManagement the first time after the UserManage-
ment administrator has defined you as new operator. You must also change your 
password after the administrator has changed your password or has forced a password 
change on you. Apart from this, you can change your password whenever you want 
either when logging into ReportDesigner or during a running ReportDesigner session.  

The new password must comply with the current password policy settings defined by 
the UserManagement administrator. Otherwise, the password will not be changed. 

To change an operator’s password: 
1. Start ReportDesigner or when in a running session, select Operator from the Help 

menu. This opens the ReportDesigner dialog. 
2. In Operator, enter your operator ID. 

Note: The operator ID does not distinguish between capital and small letters. 
3. Click Change Password. This opens the Change Password dialog. 
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4. In Operator, the ID of the operator whose password can be changed is given. If 
the password for another operator should be changed, click Cancel to return to the 
ReportDesigner dialog and repeat steps 2 and 3. 

5. In Old password, enter your current password. The password is not displayed as 
you type it. 
Note: Passwords are case-sensitive. 

6. In New password, enter the new password. 
Note: Make sure, that the new password complies with the current password 

policy settings. 
7. In Confirm new password, enter your new password again. 
8. Close the message confirming a successful password change. If an error message 

appears, repeat the corresponding steps. 
 

2.6 Locking and Unlocking an Operator 

An operator can be locked by UserManagement after too many wrong passwords are 
entered in succession. The UserManagement administrator defines how many wrong 
inputs are allowed. Also, an operator can be locked by direct UserManagement admi-
nistrator action. The operator will get information about being locked after locking has 
occurred. 

A locked operator cannot log into any Bruker Daltonics application supporting User-
Management. Only the UserManagement administrator can unlock a locked operator. 

 

2.7 Locking and Unlocking ReportDesigner and 
Other Bruker Daltonics Applications 

When ReportDesigner is running in Compliance mode, you can lock ReportDesigner 
and all other Bruker Daltonics applications currently installed on your system. Only the 
previous operator or someone with the special right to unlock applications can unlock a 
locked application.  

Note: The Lock All Applications command is only available when ReportDesigner is 
running in Compliance mode. 

Note: Automatic locking of all UserManagement using Bruker Daltonics applications 
will occur if one of these applications has not been used for a certain period 
defined by the UserManagement administrator. 
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To lock all Bruker Daltonics applications: 
1. From the Help menu, select Lock All Applications. Or press the Ctrl+Alt+K keys. 

This opens the ReportDesigner dialog that informs you that ReportDesigner is 
currently locked and how it can be unlocked. 

To unlock all Bruker Daltonics applications: 
1. In the LibraryEditor dialog, enter in Operator your operator ID. The dialog dis-

plays the name of the previous operator who has locked Bruker Daltonics applica-
tions.The respective ID will automatically be entered if the UserManagement 
administrator has set the corresponding option. 
Anyone other than the previous operator who wants to unlock the applications 
must enter their operator ID.  
Note: To do this, the operator must have the right to unlock applications. 

2. If you want to change the password before logging in, click Change Password 
and change it as desired. 

3. In Password, enter the password for the operator named in Operator. 
Note: Passwords are case-sensitive. Successive wrong password inputs will 

cause locking of the operator. 
4. Click Log On. If operator ID and password match and if the respective operator is 

allowed to unlock the applications, ReportDesigner is unlocked and the operator is 
logged in. 

 

2.8 Closing ReportDesigner 

You can close ReportDesigner when you have finished your current session. If on 
closing ReportDesigner the current processing state of an open layout file has not been 
saved yet, a corresponding confirmation request for saving this state will appear. After 
answering this request, ReportDesigner is closed. 

To close ReportDesigner: 

1. Click the application's  or select Exit from the File menu. 
2. If required, answer the appearing confirmation request for saving the unsaved 

processing state of the open layout(s). 
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3 REPORTDESIGNER USER INTERFACE 

The ReportDesigner graphical user interface consists of the title bar, the menu bar, 
several toolbars, the status bar and the layout window(s).  
 

 
Figure 3-1 ReportDesigner user interface showing two loaded DataAnalysis layouts 

arranged in cascade view 

ReportDesigner supports multi-layout operation, which means that you can have 
several layouts opened at a time with only one being active. Each loaded layout is 
displayed in a separate layout window having a title bar that shows the name of the 
loaded layout and the window's Minimize, Maximize and Close buttons except for the 
window is currently being maximized. By default, multiple layout windows are arranged 
in cascade view. The active layout is always shown on top with its title bar being 
highlighted. You can manipulate multiple layout windows with respect to their size, 
position and arrangement.  
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ReportDesigner provides several toolbars to perform general actions on the active 
layout and to insert and manipulate layout components. Pointing on a tool button will 
display the corresponding tool tip indicating the button's function. The toolbars with 
buttons for performing general actions, inserting generic components and manipulating 
layout components are docked in three rows below the menu bar by default. Docked to 
the right hand side of the layout window(s) you will find the common toolbar with 
buttons for application-independent components used in all layouts and the application-
specific toolbars with buttons for inserting application-specific components; the appli-
cation-specific toolbars available depend on the ReportDesigner-using applications 
installed on your computer. When one or more layouts are loaded only the application-
specific toolbar that corresponds to the active layout is shown. You can undock and re-
dock a toolbar and move it to another position on the user interface. 

Each layout window contains a canvas of a specified size and horizontal and vertical 
rulers. The canvas serves to place the components you want to have in the layout. It 
can show a grid whose properties can be set. A component that has been inserted and 
placed on the canvas is represented by a defined outline indicating its basic type and 
name.  

 

3.1 Customizing the User Interface 

You can customize the user interface with respect to the current display state of the 
toolbars and status bar which both are shown by default. You can undock toolbars, 
which by default are docked and re-dock them when needed. In addition, you can 
move toolbars to a new position on the user interface.  

Since ReportDesigner supports multi-layout operation using multiple windows you can 
toggle between different display modes showing only the window of the active layout or 
the windows of all layouts currently open simultaneously. In the latter case, you can 
resize and move the individual layout windows or minimize single windows to icons.  
 

3.1.1 Showing and Hiding the Status Bar 

You can hide the status bar and show it again. The status bar is positioned at the 
bottom of the ReportDesigner window. It is visible by default. 

To show or hide the status bar: 
1. From the View menu, select Status Bar. 
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3.1.2 Manipulating Toolbars 

By default, the toolbars are docked below the menu bar and right beside the layout 
window. You can hide a toolbar and show it again, undock and re-dock it and move it to 
a new position on the ReportDesigner user interface.  
 

3.1.2.1 Showing and Hiding the Toolbar 

The toolbar can be shown when currently hidden or hidden when currently visible. 

To show or hide the toolbar: 
1. From the View menu, select Toolbar. 
 

3.1.2.2 Undocking and Redocking a Toolbar 

By default, the toolbars are docked to default positions below the menu bar and right to 
the layout window(s). You can undock a currently docked toolbar or redock a currently 
undocked toolbar.  

Docked toolbars have a gripper, undocked toolbars have a title bar showing the tool-

bar's name and the . 

  
Figure 3-2 Docked (left) and undocked state (right) of a toolbar 

To undock a toolbar: 
1. Double-click on the gripper of the toolbar you want to undock. The toolbar 

becomes undocked and is displayed either at the same position if it has not been 
undocked before or at its previous undocked position.  

 -or- 
 Move the toolbar to a position outside the toolbars. The toolbar becomes undocked 

and is displayed at the selected position. 

To re-dock a toolbar: 
1. Double-click on the title bar of the desired toolbar you want to re-dock. The toolbar 

becomes docked and is displayed at its previously docked position.  
 -or- 
 Move the toolbar to a position inside the toolbars. The toolbar becomes docked 

and is displayed at the selected position. 
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3.1.2.3 Moving a Toolbar 

By default, the toolbars are docked to default positions below the menu bar and right 
beside the layout window.  

Use this procedure to move a toolbar to a new position inside or outside the toolbars. 
You can move docked as well as undocked toolbars.  

Note: While moving a toolbar its docking status may change.  

To move a docked toolbar: 
1. Position the mouse cursor on the gripper of the toolbar you want to move. Then 

drag the toolbar with left mouse button held down to the desired position and 
release mouse button. 

To move an undocked toolbar: 
1. Position the mouse cursor on the toolbar of the toolbar you want to move. Then 

drag the toolbar with left mouse button held down to the desired position and 
release mouse button. 

 

3.1.3 Manipulating Layout Windows 

ReportDesigner supports multi-layout operation, meaning that you can have several 
layouts open at a time displayed in multiple windows.  

Each loaded layout will be displayed in a separate layout window. By default, multiple 
layout windows will be arranged in cascade view with the active layout shown on top 
with its title bar being highlighted. You can arrange layout windows in different ways or 
switch to the maximized mode showing only the active layout. You can resize and 
move layout windows within the current borders of the ReportDesigner window or you 
can minimize a window if you wish to keep the respective layout open but temporarily 
exclude its window from being displayed among the other layout windows.  
 

3.1.3.1 Moving a Layout Window 

A layout window can be moved to another position on the user interface. This may 
result in only part of the layout window being shown.  

To move a layout window to another position: 
1. Position the mouse cursor on the title bar of the layout window you want to move. 
2. Drag the window with the left mouse button held down to the desired new position 

and release the mouse button.  
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3.1.3.2 Resizing a Layout Window 

You can change the size of the active layout window by dragging its borders. The 
program sets a minimum permissible size whereas the maximum possible size 
depends on the current size of the ReportDesigner window.  

You can also minimize a layout window or maximize it by clicking its  but 
maximizing will result in changing the display mode to show only the active layout, but 
not several layouts simultaneously.  

To resize the width of a layout window: 
1. Click the layout window you want to resize. 
2. Position the mouse cursor on the left or right window border so it changes to . 
3. Drag the border with the left mouse button held down to the left or right until the 

desired or the minimum/maximum window size is reached. Then release the 
mouse button. 

To resize the height of a layout window: 
1. Click the layout window you want to resize. 
2. Position the mouse cursor on the upper or lower window border so that is changes 

to . 
3. Drag the border with the left mouse button held down up or down until the desired 

or the minimum/maximum window size is reached. Then release the mouse 
button. 

To resize the height and width of a layout window simultaneously: 
1. Click the layout window you want to resize. 
2. Position the mouse cursor on the desired corner of the window so that is changes 

to e.g. . 
3. Drag the corner with the left mouse button held down in the desired direction until 

the desired or the minimum/maximum window size is reached. Then release the 
mouse button. 

 

3.1.3.3 Arranging Layout Windows 

You can use the following procedures to arrange the layout windows of all open, 
currently not minimized layouts in cascade or tile view or to switch to maximized mode 
showing the active layout only.  
When changing the display mode, the layout windows will be arranged and sized by 
default. In the case of switching to cascade view, each layout window will get the same 
default size but will be shifted by title bar height and an angle of 45°. In tile view, the 
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layout windows will be arranged as non-overlapping tiles and will be resized according 
to the current size of the ReportDesigner window, provided this does not remain under 
the minimum allowed size set for a layout window.  
If you want to show only the active layout, you can switch to the maximized mode. This 
will hide all other open layout windows. 

To arrange multiple windows in cascade view: 
1. From the Window menu, select Cascade. 

To arrange multiple windows in tile view: 
1. From the Window menu, select Tile.  

To switch to maximized mode: 

1. Click  of the layout window you want to maximize.  
 

3.1.3.4 Minimizing Layout Windows and Arranging Icons 

A layout window can be minimized to an icon. Minimizing a layout window keeps the 
corresponding layout open but excludes the respective window from being displayed 
among the other multiple windows. The icons present can be arranged in a straight line 
at the bottom of the ReportDesigner user interface. 

To minimize a layout window: 

1. Click the layout window's . This minimizes the active layout window to an icon 
e.g. 

 . 

To arrange icons of minimized layout windows: 
1. From the Window menu, select Arrange Icons. 
 

3.1.3.5 Setting up the Canvas of a Layout 

The canvas is the area of a layout window on which components can be placed. It is 
indicated by a white background whether or not showing a grid. You can set up the 
canvas to your needs e.g. you can set its size, show the grid on it and set the grid 
properties. In addition, you can zoom in the visible region of the canvas, which allows 
you to exactly place components or to obtain a general view of the components 
currently placed.  
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3.1.3.5.1 Setting the Size of the Canvas 
You can set the size of the canvas of the active layout. The canvas must set to a size 
that is sufficient to place all components that should be included in the layout.  

Note: For printing a layout, its canvas size is of no importance. The canvas width will 
always be scaled to paper width when the layout is printed and the components 
will be printed with the same height as in the layout. 

To set the size of the canvas: 
1. Activate the layout whose canvas size you want to set. 
2. From the Edit menu, select Measurement. This opens the Measurement and 

Size dialog with the Size and Units tab shown. 
3. In Unit of Measure, select the desired unit of measure. If you want to change the 

current unit, click the drop-down button and select the desired unit from the list. 
This will result in the horizontal and vertical rulers of the layout being changed. 
Note: If you change the unit of measure, the current Canvas Width and Canvas 

Height will automatically be recalculated according to the new unit set. 
4. In Canvas Width, enter the desired canvas width according to the unit of measure 

set.  
5. In Canvas Height, enter the desired canvas height according to the unit of 

measure set. 
6. Click OK. 
 

3.1.3.5.2 Showing and Hiding the Grid on the Canvas 
By default, the grid is visible on the canvas of a layout. You can hide the grid on the 
canvas of the active layout and show it again. The grid is shown according to the 
properties currently set using the Grid Properties command from the View menu. 

Note: Whether or not the grid is shown does not affect the Snap to Grid mode. This 
mode can be active even when the grid is hidden. 

To show or hide the grid: 
1. Activate the layout on whose canvas you want to show or hide the grid. 

2. Click . Or right-click on an empty space of the canvas and select Grid. Or from 
the View menu, select Grid. 
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3.1.3.5.3 Setting Grid Properties 

The properties of the grid to be shown on the canvas of the active layout are set as 
follows.  

To set grid properties: 
1. Activate the layout whose grid properties you want to set. 
2. Right-click on an empty space of the canvas and select Grid Properties. Or from 

the View menu, select Grid Properties. This opens the Grid Properties dialog. 
3. Check Grid Visible if the grid is to be shown. 
4. Check Snap to Grid if you want to activate the Snap to Grid mode. 
5. In Grid Color, select the color the grid is to be displayed in. 
6. In Grid Spacing enter the Horizontal and Vertical spaces between the single grid 

points. The values have to be entered according to the unit of measure currently 
set in the Size and Units tab of the Measurement and Size dialog. 

7. Click OK. 
 

3.1.3.5.4 Activating and Deactivating the Snap to Grid Mode 

The Snap to Grid mode can be activated or deactivated for the active layout. When 
this mode is active, component borders will automatically be anchored to grid points 
when components are inserted, moved or sized. This means, components can be 
moved or resized only in fixed steps that are defined by the current horizontal and 
vertical grid spaces set using the Grid Properties command from the View menu. 
When this mode is deactivated, components can be placed to any position on the 
canvas and can be resized to any size.  

The Snap to Grid mode is active by default. When it is active, the corresponding tool 
button is being pressed and a check mark is shown in front of the Snap to Grid 
command. 

Note: The Snap to Grid mode can be active even if the grid is currently hidden. 

To activate or deactivate the Snap to Grid mode: 
1. Activate the layout for which you want to activate or deactivate the Snap to Grid 

mode. 

2. Click . Or right-click on an empty space of the canvas and select Snap to Grid. 
Or from the View menu, select Snap to Grid. 
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3.1.3.5.5 Zooming the Visible Region of the Canvas 
The visible region of the canvas of the active layout can be zoomed. Different types of 
zooming are available. When the Zoom mode is active, the visible canvas region will be 
zoomed in or out by a fixed value of 25% each time you click with the left (zoom in) or 
right (zoom out) mouse button on the canvas. This means the first click will zoom the 
normal (100%) canvas to a magnification of 125% (zoom in) or 75% (zoom out), the 
second click to 150% or 50%. 

In addition, you can zoom the canvas to a preset scale of 50%, 75%, 100% or 200% or 
to a custom-set scale by using the corresponding menu commands. Or you can zoom 
the canvas to fit all components currently placed on the canvas or to fit only the 
selected components. This means the canvas will be zoomed so that all components 
present or all components selected are visible. 

Zooming using the Zoom mode: 
1. Activate the layout whose canvas you want to zoom. 

2. To activate the Zoom mode click  so that it becomes pressed. This displays the 
Zoom cursor  in the layout window. 

3. Depending on whether you want to zoom in or zoom out, do one of the following: 
• To zoom in, click with left mouse button on the canvas. This zooms in the 

canvas by a value of 25%. 
• To zoom out, click with right mouse button on the canvas. This zooms out the 

canvas by a value of 25% 
4. If needed, repeat clicking on the canvas until the desired magnification is reached. 
5. If you do not want to use the Zoom mode any longer, deactivate this mode. 

Depending on how you want to proceed, click  to activate the Select mode or 

 to activate the Pan mode. 

Zooming to a preset scale: 
1. Activate the layout whose canvas you want to zoom. 
2. Right-click on an empty space of the canvas, point on Zoom and select 50%, 75%, 

100% or 200%. Or in the View menu, point on Zoom Percent, and select 50%, 
75%, 100% or 200%. 

Zooming to a custom-set scale: 
1. Activate the layout whose canvas you want to zoom. 
2. From the View menu, select Zoom Custom. This opens the Zoom dialog. 
3. In Magnification, enter the percentage magnification the canvas is to be zoomed 

to. 
4. Click OK. 
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Zooming back to normal scale: 
1. Activate the layout whose canvas you want to zoom. 
2. From the View menu, select Zoom Normal. 

Zooming to fit all components placed: 
1. Activate the layout whose canvas you want to zoom. 

2. Click . Or right-click on an empty space of the canvas, point on Zoom and 
select Zoom to Fit. Or from the View menu, select Zoom to Fit. 

Zooming to selection: 
1. Activate the layout whose canvas you want to zoom. 
2. Select the components the canvas should be zoomed for to fit only the respective 

components. 

3. Click . 
 
The following examples illustrate results of different zooming operations: 

Figure 3-3     Normal scale before perfor-
ming zooming (100% mag-
nification) 

Figure 3-4     Zooming to fit showing all 
components currently con-
tained in the layout 

 
Figure 3-5     Zooming using Zoom mode,      

with Zoom cursor displayed 
Figure 3-6    Zooming to selection showing 

the selected components 
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Figure 3-7     Zooming to preset scale (here 
to 50%) 
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4 CREATING AND MANAGING LAYOUTS 

ReportDesigner allows you to create and edit your own layouts for printing reports. You 
can set up completely new layouts or modify existing layouts to your needs. This 
applies also to the Bruker designed standard layouts delivered with your system. 

Note: If you want to modify a Bruker standard layout, it is recommended not to modify 
the original layout but to save the modified layout under a new file name. Other-
wise, there is a risk that your changed layout version may become overwritten 
by a later system upgrade. 

To edit a layout you can create a new empty layout or open an existing layout and save 
it under a new or the same file name. When more than one layout is open at a time you 
have to activate the layout you want to process. If you do not want to have a layout 
open any longer, you can close it. Printing of a layout cannot be performed with 
ReportDesigner but with the application it has be designed for. 
 

4.1 Creating a New Layout 

You can create a new layout by opening a new, empty layout and inserting the compo-
nents you want to be included in this layout. Or you can save an already existing layout 
under a new file name and then modify this layout to your needs. 

To create a new empty layout: 

1. Click . Or from the File menu, select New. 
2. Edit the new layout. 
3. Save the new layout. 

To create a new layout from an existing layout: 
1. Open or activate the layout you want to change. 
2. Edit the layout. 
3. From the File menu, select Save As. 
4. In File name enter the desired new layout name. 
5. Click Save. 
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4.2 Opening an Existing Layout 

You can open an existing layout either from ReportDesigner or from Windows Explorer. 
ReportDesigner supports the drag-and-drop functionality, i.e. you can open a layout by 
dragging its file name (*.layout) from Windows Explorer into the ReportDesigner win-
dow. On opening a layout, the layout will be displayed in a new layout window. 

To open a layout from ReportDesigner: 
1. Start ReportDesigner. 

2. Click . Or from the File menu, select Open. This opens the Open dialog. 
3. In Look in and the folder list, navigate to the folder that contains the layout file 

(*.layout) you want to open. 
4. Double-click the desired layout file. Or click the desired layout file and click Open. 
Tip: You can quickly open a layout you have recently processed by clicking the 

respective recent file list name at the bottom of the File menu. 

To open a layout from Windows Explorer using drag and drop: 
1. Start ReportDesigner. 
2. Start Windows Explorer. 
3. Navigate to the folder that contains the layout file (*.layout) you want to open. 
4. Click the desired layout file and drag it with the left mouse button held down into 

the ReportDesigner window. Then release the mouse button. 

To open a layout from Windows Explorer by double-clicking it: 
1. Start Windows Explorer. 
2. Navigate to the folder that contains the desired layout file (*.layout). 
3. Double-click the layout file. This starts ReportDesigner and opens the respective 

layout. 
 

4.3 Activating a Layout 

If more than one layout is open at a time you have to activate the respective layout you 
want to view and/or process. All currently open layouts are listed in the open layout list 
at the bottom of the Window menu. The active layout is indicated by a check mark in 
front of it. 

In maximized window mode when only the active layout is shown with its correspond-
ing layout window being maximized, you can activate another layout only by selecting it 
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from the open layout list. If multiple windows are simultaneously displayed, e.g., when 
the cascade view or tile view is active, you can activate the desired layout by just 
clicking the layout window. This puts the respective layout window on top. 

To activate an open layout: 
1. From the Window menu, select the desired layout from the open layout list. Or 

click the respective layout window if visible. 
 

4.4 Saving a Layout 

You can save the current processing state of the active layout under either the same or 
another file name. To print reports with the application the respective layout has been 
designed for the layout must be saved to the corresponding application-specific folder. 
Otherwise, it will not be listed in the application's Print dialog. 

To save a layout under another file name: 
1. Activate the layout you want to save. 
2. From the File menu, select Save As. This opens the Save As dialog. 
3. Navigate to the folder the respective layout is to be saved to. 
4. Depending on whether you want to save the layout under a new or an already 

existing file name, do one of the following:  
• To save the layout under a new name, enter the desired name in File Name. 
• To save the layout under an existing name, select the desired name from the 

folder list. 
5. Click Save. 
6. If you want to save the layout under an already existing file name, affirm the 

appearing confirmation request for overwriting the existing layout file. 

To save a layout under the same file name: 
1. Activate the layout you want to save. 

2. Click . Or from the File menu, select Save. 
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4.5 Closing a Layout 

You can close the active layout if you do not want to process it further. If on closing a 
layout, its current processing state has not been saved yet, a corresponding confir-
mation request for saving this state will appear. After answering this request, the 
respective layout is closed. 

To close a layout: 
1. Activate the layout you want to close. 
2. Click the layout window's . Or from the File menu, select Close.  
3. If required, answer the appearing confirmation request. 
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5 EDITING LAYOUTS 

Note: Before you start editing layouts, it is recommended to familiarize yourself with 
the standard layouts delivered with your system to look how layouts can be 
designed. 

 
ReportDesigner designs a layout by placing components on a sheet (canvas). Usually, 
layouts consist of several different components including generic components, com-
mon components and application-specific components. You have to insert the compo-
nents you want to have in the layout and to define their properties, i.e. which 
information is to be given by the individual component and how it should be displayed 
in the printout.  

Depending on whether you want to set up a completely new layout or to modify an 
existing layout, editing a layout can include the following steps:  
• Inserting the components you want to be included in the layout 
• Defining the properties of the inserted components 
• Placing the components on the canvas where their corresponding data should 

appear on the printed report sheet 
• Checking the layout 
 

5.1 Inserting Components and Defining Their 
Properties 

To set up a layout you have to insert the components you want to be included in the 
respective layout and to define their properties. You can set default properties for 
inserting components, which will automatically be applied to a component when this is 
inserted. 
 

5.1.1 Basic Features of Components 

The ReportDesigner designs a report layout by placing layout components on a sheet.  

Basic component types 
The layout components available in ReportDesigner are of the following four basic 
types: text, graphic, table and iterator components. Application-specific components 
are indicated by blue frames, generic and common components have black frames. 
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The type of an application-specific component is shown by its outline when placed on 
the canvas:  
Text 
A text component prints 
text. 

  
Note: The display of a generic text component can be 
defined by the user.  

  
Graphic 
A graphic component 
prints a graphic, e.g. the 
active data window and 
its contents.   
Table 
A table component prints 
a table, e.g. acquisition 
parameter table, Com-
pound List, Mass List.   
  
Iterator 
An iterator component 
iterates through all its 
members, e.g. chromato-
grams, compounds, 
mass spectra. 

  

  
Components, except for 
generic components, are 
indicated by correspond-
ing component name. 

 

Component properties 
Components have properties defining their details. These include the Text, Properties, 
Selection, Table columns, Table style, Iterator, Font and/or Position and Size pro-
perties. Which properties will be available to define a particular component depends on 
the respective component. 
The current properties of a component placed on the canvas can be displayed by right-
clicking on the respective component and selecting Properties from its context menu. 
The corresponding properties are shown in the tabbed Component Properties dialog 
with the property tabs present and the parameters available depending on the currently 
selected component. 
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Figure 5-1 
Component context 
menu 
 

 
Figure 5-2 Component Properties dialog for an application-

specific component 

Components can be defined by certain of the following properties: 

Text 
The Text property is used to edit the text to be displayed in this component and to 
define the horizontal and vertical alignment of this text. 

Properties 
The Properties property is used to edit various properties of the selected component. 
The contents of this tab depend on the selected component. 

Selection 
The Selection property is used to make a selection from various parameters. The type 
of the parameters present depends on the selected component. Depending on the 
component, multiple selection is possible. 

Table columns 
The Table columns property is used to define the columns of the selected table 
component. 

Table style 
The Table style property is used to define the style of the table of the selected table 
component. This includes the font size and style of the table header, the font size of the 
table items and the amount of space between the table columns. 

Iterator 
The Iterator property is used to define the number of columns and the gap between 
the columns of the selected iterator component. 
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Font 
The Font property is used to define the font and font size the text of the selected 
component is to be printed with. 

Position and Size 
The Position and Size property displays information about the current position and 
size of the selected component. 
 
The component properties and parameters that will be available for the individual 
application-specific components are described in the respective application-specific 
program features. 
 

5.1.2 Setting Default Properties for Inserting Components 

For the active layout you can set default properties to be used when inserting compo-
nents. The currently set default properties will automatically be applied to a component 
when this is inserted in the layout.  

Depending on the type of component to be inserted, the default properties will define 
which editing operations are allowed, how component lines are drawn (for generic 
Rectangle and Line components only), how components are filled (generic Text and 
Rectangle components only) and which font and font size is used for text displayed in 
this component. 

To set default properties for inserting components: 
1. Activate the layout for which you want to set default properties for inserting compo-

nents. 
2. Right-click on an empty space of the canvas and select Default Properties. Or 

from the Edit menu, select Default Properties. This opens the Default Properties 
dialog. 

3. In the Edit tab, select which General Edit and Graphic Edit operations should be 
allowed to be performed on the component. 

4. Click the Line tab and select the Color, Style and Width to be used to draw lines 
of a Rectangle or Line component. 

5. Click the Fill tab and select Foreground Color, Background Color and Hatch to 
be used to fill a Text or Rectangle component. 

6. Click the Font tab and select the font and font size to be used to print text in the 
component. 

7. Click OK. 
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5.1.3 Inserting a Component 

You can insert a component in the active layout. All components you can insert in a 
particular layout are represented by enabled tool buttons in the Drawing, Common 
Components and application-specific toolbars.  

Before inserting components in a layout, you can define default properties for this 
layout, which will automatically be applied to the components when inserted. 

To insert a component, you first have to select the desired component by clicking the 
corresponding tool button so that it becomes pressed. Then you have to move the 
mouse cursor to a position on the canvas and click left mouse button. This inserts the 
respective component with a default size. This procedure applies to all components 
except for generic Rectangle or Line components for which you have to draw the 
desired rectangle or line by using the mouse. When the Snap to Grid mode is active, 
the top and left borders of a component are automatically placed at grid points. Once a 
component has been inserted, you can define its properties and handle it as needed. 

Tip: You can also insert a component that has previously been put onto the Clipboard 
by pasting it in the active layout.  

To insert a component: 
1. Activate the layout in which you want to insert a component. 
2. Set the default properties for inserting components, if desired. 
3. Click the tool button that corresponds to the component you want to insert so that it 

becomes pressed. 
4. Navigate the mouse cursor to that position on the canvas where you want to insert 

the selected component. 
5. Click with left mouse button on the canvas or, in the case of a generic Rectangle 

and Line component, draw the rectangle or line while keeping left mouse button 
held down. 

 

5.1.4 Defining the Properties of a Component 

You can define the properties of the selected component of the active layout. Each 
component has specific properties that define which information will be given by this 
component and how it will be displayed when the report is printed.  

The properties of a component are set using the Properties command of the Edit 
menu, which opens the Component Properties dialog. The contents of this dialog, i.e. 
the tabs and the parameters present, depend on the type of component currently 
selected.  
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To define the properties of a component: 
1. Select the component whose properties you want to define. 
2. Right-click on the component and select Properties. Or from the Edit menu, select 

Properties. 
3. In the Component Properties dialog, subsequently click the tabs available and 

set the parameters present as desired.  
 Depending on the component currently selected certain of the following tabs will be 

present: Properties, Selection, Table columns, Table style, Iterator, Font, 
Position and Size, Text and/or Line.  

4. Click OK. 
 

5.2 Handling Components 

To edit a layout you have to place the components on the canvas where the corre-
sponding results should appear in the printout. For example, you can copy or cut out a 
component and paste it in the same or another layout. You can also resize a com-
ponent, move it to a new position, set its order within a set of overlapping components 
or align it with another component. In addition, you can delete a component you do not 
want to have in the layout any longer. 
 

5.2.1 Selecting a Component 

The component you want to process has to be selected. Using multiple selection, you 
can select several components at once. 

Components can only be selected when the Select mode is active which is indicated by 

the  being pressed and the mouse cursor  being displayed in the layout window.  

Eight quadratic handles mark a selected component. When a single component is 
selected, these handles are displayed in gray. When more than one component is 
selected, only the last selected one shows gray handles, the others have white 
handles. Within a multiple selection, the component with the gray handles is the so-
called anchor component which serves as reference, e.g. when aligning components or 
resizing components to the same size.  

   
Figure 5-3 Selecting components: single component (left) and multiple components 

with anchor component shown in the middle (right) 
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To select a single component: 

1. To activate the Select mode, click  so that is becomes pressed. 
2. Position the mouse cursor on the component you want to select and click the left 

mouse button. 

To select multiple components: 

1. To activate the Select mode, click  so that is becomes pressed. 
2. Hold down the Shift or Ctrl key and subsequently click with the left mouse button 

on each component you want to select. Then release the key. 

 

5.2.2 Copying a Component 

You can copy a selected component of the active layout and put the copy onto the 
Clipboard. This allows you to insert the copied component in either the same or 
another layout by using the Paste command from the Edit menu. Using multiple 
selection, you can copy several components at once. 

To copy a component: 
1. Select the component(s) you want to copy. 

2. Click . Or right-click on the component and select Copy. Or from the Edit 
menu, select Copy. 

3. If desired, paste the copied component(s) into the same or another layout.  
 

5.2.3 Cutting a Component 

You can cut a selected component out off the active layout which results in the respec-
tive component being removed from the canvas but put onto the Clipboard. This allows 
you to insert this component again either in the same or another layout, by using the 
Paste command from the Edit menu. Using multiple selection, you can cut several 
components at once. 

To cut out a component: 
1. Select the component(s) you want to cut out. 

2. Click . Or right-click the component and select Cut. Or from the Edit menu, 
select Cut. 

3. If desired, paste the cut out component(s) into the same or another layout.  
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5.2.4 Pasting a Component 

You can paste the component(s) currently contained on the Clipboard into the active 
layout. Before pasting, you can select the insertion position with the mouse. If no 
position is specified, the Clipboard contents will be inserted at the upper left corner of 
the canvas. 

To paste a component into a layout: 
1. Activate the layout, into which the current Clipboard contents is to be pasted. 
2. Position the mouse cursor on the canvas at the desired insertion position and do 

one of the following: 
Right-click on the canvas and select Paste. Or left-click on the canvas and then 

click  or from the Edit menu, select Paste. 
 

5.2.5 Deleting a Component 

You can delete a selected component from the active layout. Deleting a component 
does not result in putting the respective component onto the Clipboard, which is in 
contrast to cutting out a component. Using multiple selection, you can delete several 
components at once. 

To delete a component: 
1. Select the component(s) you want to delete. 
2. From the Edit menu, select Delete. 
 

5.2.6 Resizing Components 

Components can be resized by dragging their borders or by making them the same 
height, width or size as the selected reference component. 
 

5.2.6.1 Enlarging or Reducing the Size of a Component 

You can enlarge or reduce the size of a selected component by dragging its borders. 
Using multiple selection, you can resize several components at once.  

You can resize a single or multiple selected components by dragging their horizontal 
and/or vertical borders using the mouse. If multiple selected components differ in 
height and/or width, then dragging the border of one of the selected components will 
result in all selected components being resized according to their relative heights and/ 
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or widths. When the Snap to Grid mode is active, dragging of borders can be per-
formed only in fixed steps, which are defined by the grid spacing currently set. 

Enlarging of multiple selected components may result in the components becoming 
(partially) overlapped. If needed, move the respective component(s) to another position 
on the canvas.  

To enlarge and/or reduce the size of a component: 
1. Select the component(s) whose size you want to change. 
2. Position the mouse cursor on a handle of the border you want to drag so that it 

changes to   or .  
 If you want to change the height and width of the component simultaneously, posi-

tion the cursor on the respective corner handle so that the corresponding cursor, 
e.g. , appears.  
Note: If multiple components are selected that differ in height, width and/or size, 

position the cursor on the desired handle of the component you want to use 
as reference. 

3. Drag the cursor with the left mouse button held down in the desired direction until 
the desired new size is reached. Then release mouse button. During dragging, the 
current size of thecomponent(s) is continuously updated and displayed by dashed 
lines. 

 

5.2.6.2 Making Components the Same Size 

You can adjust the current height, width or size of a selected component with respect 
to the height, width or size of the selected anchor component. This results in making 
both components the same height, width or size without changing the current canvas 
position of the top and left component borders. Using multiple selection, you can resize 
several components at once. 

Enlarging of multiple selected components may result in the components becoming 
(partially) overlapped. If needed, move the respective component(s) to another position 
on the canvas. 

To make components the same height, width or size: 
1. Select the components you want to make the same height, width, or size. The 

component you want to use as reference (anchor component) must be selected 
last. 

2. Depending on whether you want to make the same height, width or size, do one of 
the following: 

• Click  to make components the same height.  
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• Click  to make the components the same width. 

• Click  to make the components the same size.  

  

  
Figure 5-4 Making components the same size: before (above) and after (below) mak-

ing same size is performed  
 

5.2.7 Placing Components 

The components you want to have in the layout have to be placed on the canvas as 
their corresponding data should appear on the printed report sheet. Exceptions are the 
Page Header and Page Footer components, which must be placed at the end of the 
layout. Otherwise, there will be a gap in the printout. 

To arrange components on the canvas, you can move components to another position 
by using the mouse or the nudge tool buttons if you want to change a component's 
position only by a few pixels. You can align components and space them evenly. To 
keep components together you can group them. 

Components are allowed to be placed with overlapping borders except for iterators and 
included components. Here, components must be placed inside the iterator component 
without any overlapping of iterator borders with included component borders. Other-
wise, an error message will appear when the layout is saved. For overlapping compo-
nents, you can define their z-order. 
 

5.2.7.1 Moving a Component 

You can move a selected component of the active layout by dragging it with the mouse 
to another position on the canvas. Using multiple selection, you can move several com-
ponents at once. In addition, you can simultaneously move multiple components if they 
have been grouped. 
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When the Snap to Grid mode is active, components can be moved only in distinct 
steps, which will be defined by the current grid properties. The current canvas position 
and size of a selected component is shown in the Position and Size tab of the corre-
sponding Component Properties dialog. 

Tip: You can also change the current position of a component by cutting it out and 
then pasting it at the desired canvas position. 

To move a component: 
1. Select the component(s) you want to move. 

2. Position the mouse cursor on the selection so that it changes to  and drag the 
selection with the left mouse button held down to the desired new canvas position. 
Then release the mouse button. During dragging, the component's current position 
is continuously updated and displayed by a dashed rectangle. 

 

5.2.7.2 Nudging a Component 

You can nudge a selected component by 1 pixel up, down, to the left or right. With the 
SHIFT key held down, you can nudge by 5 pixels. Using multiple selection, you can 
nudge several components at once. 

To nudge a component: 
1. Select the component(s) you want to nudge. 
2. Press the SHIFT key if you want to nudge the component(s) by 5 pixels. 
3. Depending on the direction in which you want to nudge the component(s), do one 

of the following: 

• Click  to nudge the component up. Or press ↑ key. 

• Click  to nudge the component down. Or press ↓ key.  

• Click  to nudge the component to the left. Or press ← key. 

• Click  to nudge the component to the right. Or press → key. 
 

5.2.7.3 Aligning a Component with Another 

You can align a selected component with the anchor component. Aligning can be 
performed with respect to the anchor component's top, bottom, left or right border or its 
horizontal or vertical center. For example, when 'Align Top' is performed, the top bor-
ders of the selected components will be aligned in a straight horizontal line with the top 
border of the anchor component serving as reference. Using multiple selection, you 
can align several components at once. 
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Aligning components may result in components becoming (partially) overlapped. If 
needed, move the respective component(s) to another position on the canvas. 

To align a component with another: 
1. Select the components you want to align. The component you want to use as 

reference (anchor component) must be selected last. 
2. Depending on how the selected components should be aligned, do one of the 

following: 

• Click  to align the components' top borders in a straight horizontal line.  

• Click  to align the components' vertical centers in a straight horizontal line.  

• Click  to align the components' bottom borders in a straight horizontal line. 

• Click  to align the components' left borders in a straight vertical line. 

• Click  to align the components' horizontal centers in a straight vertical line. 

• Click  to align the components' right borders in a straight vertical line. 
 

 

  
Figure 5-5 Aligning components: before (above) and after (below) aligning of top 

borders is performed 
 

5.2.7.4 Changing the Z-Order of Overlapping Components 

You can change the z-order of overlapping components. This is necessary if you want 
to select a component that is completely covered by a component lying on top. For 
example, you cannot select a component placed inside an iterator component when the 
iterator component currently lies on top. You will always select the iterator component. 
When printing components the z-order has no influence. 

To change the z-order of a component: 
1. Select the component whose z-order you want to change. 
2. Depending on how you want to change the component's z-order, do one of the 

following: 
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• Click  to bring the component to front. 

• Click  to send the component back.  

• Click  to bring the component forward. 

• Click  to send the component backward.  
 

5.2.7.5 Spacing Components Evenly 

You can space the selected components of the active layout evenly. This applies to 
horizontal or vertical spaces. At least three components have to be selected. Spacing 
evenly results in the outer components remaining at their current places but the inner 
component(s) being moved either horizontally or vertically by adjusting the spaces 
between all selected components to the same width or height. 

To space components evenly: 
1. Select the components you want to space evenly by adjusting either horizontal or 

vertical spaces. It does not matter which of the respective components will be 
selected last. 

2. Depending on whether horizontal or vertical spaces are to be adjusted, do one of 
the following: 

• Click  to adjust the horizontal spaces between the components. 

• Click  to adjust the vertical spaces between the components. 
 

  

  
Figure 5-6 Spacing components evenly: Before (above) and after (below) horizontal 

spacing is performed 

 

5.2.7.6 Grouping and Ungrouping Components 

You can group or ungroup multiple selected components. Grouping of components has 
two functions. Grouped components will be 
- kept together in ReportDesigner e.g. while being moved. 



Editing Layouts Bruker Daltonik GmbH 

 ReportDesigner User Manual, Version 4.5 5-14 

- printed in the printout on the same page. This means if a component group is to be 
printed but the remaining space is not sufficient to print the entire group, then the 
group will be printed on the next page.  

When components are grouped, the individual components of the group cannot be 
selected or handled. Only the entire group can be handled e.g. moved or resized which 
results in all members of the group being moved or resized accordingly. A group of 
components is indicated by a common set of handles including the components. To 
handle an individual component of the group or to edit its component properties you 
have to ungroup the group.  

To group components: 
1. Select the components you want to group. 
2. Right-click on a selected component point on Grouping and select Group. 

To ungroup components: 
1. Select the group of components you want to ungroup. 
2. Right-click on a component of this group, point on Grouping and select Ungroup. 

       
Figure 5-7 Grouping components: selection of components to be grouped (left) and 

grouped components (right) 

5.3 Tips and Guidelines on How to Edit Layouts 
When editing a layout, please consider to the following points, which may help you in 
designing a layout: 

• Each layout should have a Page Header and Page Footer component. Both compo-
nents are containers, i.e. the components placed in them will be printed as header 
and footer on each page.  
The Page Header component should contain a generic Text component that indi-
cates the report type. In the Page Footer component, you can place the Print Date, 
Print Time and/or Page Number components to print general report data as print 
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date, print time and page number. Additionally, generic Text components giving infor-
mation on the data printed can be inserted. 
The Page Header and Pager Footer components must always be placed at the end 
of the layout. Otherwise, there will be a gap in the printout. 

  
Figure 5-8 Page Header and Page Footer components containing generic and Com-

mon components 
• Components that are designed to print only one single information, e.g. analysis or 

batch information, can be inserted multiple times in a layout with each of them print-
ing another specified information (see figure below).  

• It is useful to place components that print related data as e.g. analysis information or 
acquisition parameters in groups getting a header.  

• To print user-defined text, you can insert generic Text components in the layout. This 
can be a group or table header or information about which kind of data is printed by a 
respective component (e.g. 'Analysis Name', 'Method', 'Operator').  

  
Figure 5-9 Application specific components (blue frames) with generic Text com-

ponents placed in front (black frames) 

Inserting explanatory text components is not needed for components that are 
designed to print the respective information. For example:  
- Acquisition parameter components are designed to print either the name or the 

value of the selected parameter. Thus, if you want to print both parameter name 
and value you can twice insert the desired component, arrange the components in 
pairs and select for both components the same acquisition parameter but set the 
first component to 'Name' and the second to 'Value'.  

 
   Figure 5-10 Pairs of acquisition parameter components 

- Acquisition parameter table components are designed to print both name and value 
of the selected acquisition parameters.  

- Table components are designed to print the corresponding column headers except 
for acquisition parameter table components. 
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• For iterator components, it has to be defined which data is to be printed for the mem-
bers the respective iterator will iterate through. For this, you have to place the desired 
component(s) into the respective iterator component. This may include a further 
iterator component e.g. a spectrum iterator that is placed in a compound iterator.  
Note:  Take care of that borders of the iterator component and of components 

placed inside do not overlap. 

  
Figure 5-11  Iterator component containing two components placed inside 

• When a report is printed, the components will be printed with the same height as in 
the layout except for table and multi-line text components. These have a variable 
height because the actual space that is needed to print the component depends on 
data extend currently to be printed.  

• Normally, the data of a report will be printed continuously, i.e. page breaks will occur 
when the remaining space on a page is not sufficient to print the next data.  
If you do not wish that page breaks occur randomly, which may result in components 
belonging together being separated, you can group components, which will prevent 
the components from being printed on different pages. 
You can insert a Page Break component to cause a page break at a specified posi-
tion in the report. For example, this might be useful for iterator components printing 
large graphics and/or tables. Placing a Page Break in an iterator component will 
result in the data of each member of the iterator being printed on a new page. Where 
to place the Page Break component, i.e. at the top or the bottom of the iterator 
component, depends on the amount of data to be printed on the first page of the 
report before the data of the iterator component is printed. Inserting a Page Break 
component at the bottom of the iterator component will print the data of the first 
member of the iterator on the first page, the data of the second member on the 
second page and so on. Inserting a Page Break component just below the top 
border of an iterator component will cause a page break before the data of the first 
member of the iterator component is printed.  
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Figure 5-12  Page Break component placed in an iterator component which prints 

extensive data for each of its members 

• When placing components, component borders are allowed to overlap except for 
iterator and included components. If a border of an iterator component and a border 
of a component placed inside overlap, an error message will appear when the layout 
is saved. 

• After setting up a new layout, you should check it in the respective application it has 
been designed for by printing a corresponding report for an appropriately processed 
analysis or batch. In the resulting printout, you can check if all components you want 
to have in the respective report are present and are printed correctly, i.e. without any 
texts, graphics, or tables e.g. being overlapped or cut off.  

 

5.4 Printing Layouts 

Layouts cannot be printed with ReportDesigner but with the application, they have 
been designed for. Therefore, when you have edited a new layout, you can print it by 
creating a corresponding report in the respective application. For this, the layout must 
be saved to the appropriate folder.  

When a layout is printed, the following transformations will be made: 

Width: The components will be scaled so that the layout fits into the paper (canvas 
width of the layout = paper width). 

Height: The components will be printed with the same height as in the layout except for 
Table and Multi Text components because they have a variable height. 

Margins: There is a fixed margin of 2 cm at the top and bottom of each page. 
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6 BASIC LAYOUT COMPONENTS 

ReportDesigner provides a great variety of layout components for printing specific 
reports. The basic components include the Generic components and the Common 
components. They are always available and apply to all applications.  

In addition to the basic components, application-specific components will be available 
as well depending on the Bruker Daltonics software package(s) installed on your 
system. These respective components are described in the application-specific pro-
gram features. 
 

6.1 Generic Components 

ReportDesigner provides the following generic components for printing reports with all 
applications. The following tool buttons in the Drawing toolbar, which is docked below 
the menu bar by default, represent the generic components available:  

  

Figure 6-1 Drawing toolbar 

 Line  

 Rectangle  

 Text  

 Image  
 

6.1.1 Rectangle Component 

The generic Rectangle component prints a rectangle. How the lines of the rectangle 
are to be drawn is defined via the component's Line property. 

Button:  
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6.1.2 Line Component 

The generic Line component prints a line. How the line is to be drawn is defined via the 
component's Line property. 

Button:  

 

6.1.3 Text Component 

The generic Text component prints a specified text. The text to be printed is defined via 
the component's Text property. 

Type: Text 

Button:  

 

6.1.4 Image Component 

 The generic Image component prints a selected image e.g. a company logo. The 
desired image has to be specified in the Open dialog, which will appear when the tool 
button is clicked. 

Note: 16-colors graphics are not supported. If you insert such a graphic, it will not be 
displayed. 

Type: Graphic 

Button:   

 
 

6.2 Common Components 

ReportDesigner provides the following common components for printing reports with all 
applications. These components are used to define the page header and page footer of 
a report layout. The following tool buttons in the Common Components toolbar, which 
is docked right to the layout window by default, represent the common components 
available: 



Bruker Daltonik GmbH Basic Layout Components 

ReportDesigner User Manual, Version 4.5  6-3

  

Page Number  
Page Header  
Page Footer  
Page Break  
Print Date  
Print Time  
Print Date and Time  

Figure 6-2 Common Components toolbar 
 

6.2.1 Page Number Component 

The Page Number component prints the current page number including the total 
number of pages. It is recommended to place this component in the Page Footer or 
Page Header component. 

Type: Text 

Button:  

 

6.2.2 Page Header Component 

The Page Header component is a frame (container) for the page header components. 
The component(s) contained in it will be printed as header on each page. (Note:  There 
will be a fixed margin of 2 cm at the top of each page.) 

Type: none 

Button:  

6.2.3 Page Footer Component 

The Page Footer component is a frame (container) for the page footer components. 
The component(s) contained in it will be printed as footer on each page. (Note:  There 
will be a fixed margin of 2 cm at the bottom of each page.) 

Type: none 

Button:  
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6.2.4 Page Break Component 

The Page Break component inserts a page break at the given position. 

Type: none 

Button:  

 

6.2.5 Print Date Component 

The Print Date component prints the date of printing. The format of the string will be 
taken from the Regional Settings in Windows. It is recommended to place this 
component in the Pager Footer or Page Header component. 

Type: Text  

Button:  

 

6.2.6 Print Time Component 

The Print Time component prints the time of printing. The format of the string will be 
taken from the Regional Settings in Windows. It is recommended to place this 
component in the Pager Footer or Page Header component. 

Type: Text 

Button:    

 

6.2.7 Print Date and Time Component 

The Print Date and Time component prints the date and time of printing. The format of 
the string will be taken from the Regional Settings in Windows. It is recommended to 
place this component in the Pager Footer or Page Header component. 

Type: Text 

Button:   
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7 DATAANALYSIS COMPONENTS 

Note: The DataAnalysis components are only available if DataAnalysis is installed on 
your system. 

ReportDesigner provides in the DataAnalysis Components toolbar buttons for the 
following DataAnalysis components. The toolbar is shown when ReportDesigner was 
started without opening a specified layout or when a DataAnalysis layout is active. 
 

  

Analysis Info  
Analysis Description  
Acquisition Parameter  
Acquisition Parameter Table  
LC Acquisition Parameter  
Sample Info 
Method Part  
Display  
Analyses Iterator  
Survey View 
Chromatograms Iterator  
Chromatogram  
Compounds Iterator  
Compound Name  
Compound List  
Spectra Iterator  
Work List Iterator 
Spectrum  
Mass List  
Deconvolution Results  
SmartFormula Table 
Calibration Info  
Script Table  
Scripting Variable  
Signer Table  
Signer List  
Application Name  

Figure 7-1 DataAnalysis Components toolbar 
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This User Manual describes the individual DataAnalysis components only with respect 
to their function. Which component properties you can set for a certain component and 
how is described in detail in the ReportDesigner Reference Manual. 
 

7.1 Analysis Info Component 

The Analysis Info component prints one element from the analysis information of an 
analysis. The element to be printed is defined via the component's Selection property. 
A layout can contain several Analysis Info components, each of them printing different 
analysis information. 

Type: Text 

Button:   
 

7.2 Analysis Description Component 

The Analysis Description component prints the analysis description of an analysis. 

Type: Multi Line Text 

Button:  
 

7.3 Acquisition Parameter Component 

The Acquisition Parameter component prints one item from the acquisition parame-
ters of an analysis. The parameter to be printed is defined via the component's Selec-
tion property. 

Selection of acquisition parameters requires an analysis to be selected for the active 
layout. An appropriate analysis can be loaded using the Select Analysis command 
from the DataAnalysis menu.  

Type: Text 

Button:  
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7.4 Acquisition Parameter Table Component 

The Acquisition Parameter Table component prints a table of acquisition parameters 
of an analysis. This table contains the parameter names and corresponding values. 
The parameters to be printed are defined via the component's Properties and 
Selection properties. 
Selection of acquisition parameters requires an analysis to be selected for the active 
layout. An appropriate analysis can be loaded using the Select Analysis command 
from the DataAnalysis menu. 

Type: Table 

Button:  
 

7.5 LC Acquisition Parameter Component 

The LC Acquisition Parameter component prints LC acquisition parameters of an 
analysis. The LC acquisition program enters the parameters that correspond to the 
different components of the LC system into the respective analysis folder. The LC 
parameters to be printed are defined via the component's Table column property. 

Type: Multi Line Text 

Button:   
 

7.6 Sample Info Component 

The Sample Info component prints specific data of the HyStar sample info of the 
selected analysis. The data to be printed is defined via the component's Properties 
property. 

Type: Table 

Button:   
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7.7 Method Part Component 

The Method Part component prints the DataAnalysis method part of the selected ana-
lysis. 

Type: Text 

Button:   
 

7.8 Display Component 

The Display component prints the current DataAnalysis window. Which open data 
window(s) and which data are to be printed is defined via the component's Properties 
property. 

Type: Graphic  

Button:  
 

7.9 Analyses Iterator Component 

The Analyses Iterator component iterates through all analyses currently open in 
DataAnalysis or only the enabled ones. All layout components that are placed inside an 
Analyses Iterator component will be applied to the analysis that is iterated. Therefore, 
with one layout several analyses can be printed at a time. The analyses to be iterated 
are defined via the component's Properties property. Which analyses are to be 
iterated is defined via the component's Properties property. 

Type: Iterator 

Button:  
 

7.10 Survey View Component 

The Survey View component prints the Survey View of an analysis. The retention time 
range to be printed is defined via the component's Properties property. 

Type: Graphic  

Button:   
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7.11 Chromatograms Iterator Component 

The Chromatograms Iterator component iterates through all chromatograms of an 
analysis. All layout components that are placed inside a Chromatograms Iterator 
component will be applied to the chromatogram that is iterated. Therefore, with one 
layout several chromatograms can be printed at a time. Which chromatograms should 
be iterated is defined via the component's Properties property. 

Type: Iterator 

Button:  
 

7.12 Chromatogram Component 

The Chromatogram component prints one or more chromatograms of an analysis. 
Which chromatogram(s) is/are to be printed and how is defined via the component's 
Properties property.  

Type: Graphic 

Button:  
 

7.13 Compounds Iterator Component 

The Compounds Iterator component iterates through all compounds of an analysis. 
All layout components that are placed inside a Compounds Iterator component will be 
applied to the compound that is iterated. Therefore, with one layout several compounds 
can be printed at a time. Which compounds should be iterated is defined via the 
component's Properties property. 

Type: Iterator 

Button:  
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7.14 Compound Name Component 

The Compound Name component prints the name of the current compound.  

Note: This component will only work within a Compounds Iterator component. 
Type: Text 

Button:  
 

7.15 Compound List Component 

The Compound List component prints a Compound List of an analysis. Which 
columns should be printed is defined via the component's Properties property. The 
columns either can be taken over from DataAnalysis or be defined in ReportDesigner 
via the component’s Table columns property. If columns should be taken oven from 
DataAnalysis, that Compound List Layout will be used that is currently defined for the 
respecttive analysis in DataAnalysis when printing of the report is started. 

Type: Table 

Button:  
 

7.16 Spectra Iterator Component 

The Spectra Iterator component iterates through spectra. All layout components that 
are placed inside a Spectra Iterator component will be applied to the spectrum that is 
iterated. Therefore, with one layout several spectra can be printed at a time. Which 
spectra are iterated depends on the context. Within a compound iterator, the spectra of 
the respective compound will be iterated. Outside of a compound iterator, the spectra 
of a single mass spectrum analysis will be iterated. However, the spectra to be iterated 
are defined via the component's Properties property. 

Type: Iterator 

Button:    
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7.17 Work List Iterator Component 

The Work List Iterator component iterates through the spectra in the Work List if a 
Spectrum component is placed inside it 

Type: Iterator 

Button:   
 

7.18 Spectrum Component 

The Spectrum component prints one or more mass spectra. Which mass spectrum/ 
spectra is/are to be printed and how is defined via the component's Properties proper-
ty. 

Type: Graphic 

Button:  
 

7.19 Mass List Component 

The Mass List component prints a Mass List of a mass spectrum. How peaks should 
be selected to be included in the printed Mass List and which columns should be 
printed is defined via the component's Properties property. The columns to be printed 
either can be taken over from DataAnalysis or be defined in ReportDesigner via the 
component’s Table columns property. If columns should be taken oven from DataAna-
lysis, that Mass List Layout will be used that is currently defined for the respecttive 
analysis in DataAnalysis when printing of the report is started. 

Type: Table 

Button:    
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7.20 Deconvolution Results Component 

The Deconvolution Results component prints the deconvolution results of a mass 
spectrum. Which results are to be printed is defined via the component's Properties 
property. 

Type: Text 

Button:  
 

7.21 SmartFormula Table Component 

The SmartFormula Table component prints SmartFormula results of a mass 
spectrum. Which columns should be printed is defined via the component's Properties 
property. The columns to be printed can either be taken over from DataAnalysis or be 
defined in ReportDesigner via the component’s Table columns property.  

Type: Table 

Button:   
 

7.22 Calibration Info Component 

The Calibration Info component prints the calibration status data of the selected 
analysis that is shown in DataAnalysis in the Properties - Calibration Status dialog. 

Type: Text 

Button:   
 

7.23 Scripting Table Component 

The Scripting Table component prints a table containing values of a variable of an 
analysis that have been saved via the automation ScriptVariable property. The variable 
whose corresponding values are to be printed is defined via the component's Pro-
perties property. 

Type: Table 

Button:   
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7.24 Scripting Variable Component 

The Scripting Variable component prints a variable of an analysis that has been 
saved via the automation ScriptVariable property. The variable whose corresponding 
value is to be printed is defined via the component's Properties property. 

Type: Text 

Button:   
 

7.25 Signer Table Component 

The Signer Table component prints detailed signing information. The columns to be 
printed are defined via the component's Table columns property.  

Type: Table 

Button:   
 

7.26 Signer List Component 

The Signer List component prints the names of all signers in succession. It is intended 
for placing signing information into the header or footer. 

Type: Text 

Button:   
 

7.27 Application Name Component 

The Application Name component prints the application name and version number. 
For example, for Bruker Compass applications ‘Bruker Compass’ is placed in front e.g. 
‘Bruker Compass DataAnalysis 4.0’. 

Type: Text 

Button:   
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8 QUANTANALYSIS COMPONENTS 

Note: The QuantAnalysis components are only available if QuantAnalysis is installed 
on your system. 

ReportDesigner provides in the QuantAnalysis Components toolbar buttons for the 
following QuantAnalysis components. The toolbar is shown when ReportDesigner was 
started without opening a specified layout or when a QuantAnalysis layout is active. 
 

  

Batch Info  
Acquisition Parameter Table  
LC Acquisition Parameter  
Method Parameter  
Method Table  
Work Table  
Analyses Iterator  
Analysis Name  
Analysis Info  
Chromatogram  
Spectrum  
Compounds Iterator  
Compound Name  
Compound List  
Calibration Blocks Iterator  
Calibration Curve  
Calibration Block Number  
Audit Trail  
Signer Table  
Signer List  
Application Name  

Figure 8-1 QuantAnalysis Components toolbar 

This User Manual describes the individual QuantAnalysis components only with 
respect to their function. Which component properties you can set for a certain compo-
nent and how is described in detail in the ReportDesigner Reference Manual.  
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8.1 Batch Info Component 

The Batch Info component prints one element from the batch information of the loaded 
batch. The element to be printed is defined via the component's Selection property. A 
layout can contain several Batch Info components, each of them printing different 
batch information. 

Type: Text 

Button:   
 

8.2 Acquisition Parameter Table Component 

The Acquisition Parameter Table is component prints a table of acquisition parame-
ters of the loaded batch. This table contains the parameter names and corresponding 
values. The parameters to be printed are defined via the component's Selection and 
Properties property. 

Selection of acquisition parameters requires an analysis to be selected for the active 
layout. An appropriate analysis can be loaded using the Select Analysis command 
from the QuantAnalysis menu.  

Type: Table 

Button:  
 

8.3 LC Acquisition Parameter Component 

The LC Acquisition Parameter component prints LC acquisition parameters of the 
loaded batch. The LC acquisition program enters the parameters that correspond to the 
different components of the LC system into the respective analysis folder. The LC 
acquisition parameters to be printed are defined via the component's Table column 
property. 

Type: Multi Line Text 

Button:   
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8.4 Method Parameter Component 

The Method Parameter component prints one element from the general quantitation 
method parameters of the loaded batch. The element to be printed is defined via the 
component's Selection property. 
Type: Text 

Button:  
 

8.5 Method Table Component 

The Method Table component prints quantitation method data of the loaded batch. 
The columns to be printed are defined via the component's Table columns property. 
Type: Table 

Button:  
 

8.6 Work Table Component 

The Work Table component prints the Work Table of the loaded batch. The columns to 
be printed are defined via the component's Table columns property. 
Note: The compound specific columns will only be printed within a compound iterator. 

Type: Table 

Button:  
 

8.7 Analyses Iterator Component 

The Analyses Iterator component iterates through all analyses of the loaded batch. All 
layout components that are placed inside an Analyses Iterator component will be 
applied to the analysis that is iterated. Therefore, with one layout several analyses can 
be printed at a time. 
Type: Iterator 

Button:   
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8.8 Analysis Name Component 

The Analysis Name component prints the name of the current analysis. 
Note: This component will only work within an Analyses Iterator component. 

Type: Text 

Button:   
 

8.9 Analysis Info Component 

The Analysis Info component prints one element from the analysis information of an 
analysis. The element to be printed is defined via the component's Selection property. 
A layout can contain several Analysis Info components, each of them printing different 
analysis information. 

Note: This component will only work within an Analyses Iterator component. 
 
Type: Text 

Button:   
 

8.10 Chromatogram Component 

The Chromatogram component prints one or more chromatograms of the current ana-
lysis. Which chromatogram(s) is/are to be printed and how is defined via the compo-
nent's Properties property.  
Note: This component will only work within an Analyses Iterator component. 

Type: Graphic 

Button:   
 
 
 
 
 
 



Bruker Daltonik GmbH QuantAnalysis Components 

ReportDesigner User Manual, Version 4.5  8-5

8.11 Spectrum Component 

The Spectrum component prints one or more mass spectra of the current analysis. 
Which mass spectrum/spectra is/are to be printed and how is defined via the compo-
nent's Properties property. 
Note: This component will only work within an Analyses Iterator component. 
Type: Graphic 

Button:   
 

8.12 Compounds Iterator Component 

The Compounds Iterator component iterates through all compounds of the loaded 
batch. All layout components that are placed inside a Compounds Iterator component 
will be applied to the compound that is iterated. Therefore, with one layout several 
compounds can be printed at a time. 
Type: Iterator 

Button:  
 

8.13 Compound Name Component 

The Compound Name component prints the name of the current compound. 
Note: This component will only work within a Compounds Iterator component. 
Type: Text 

Button:  
 

8.14 Compound List Component 

The Compound List component prints the Compound List of the current analysis. The 
columns to be printed are defined via the component's Table columns property.  
Note: This component will only work within an Analyses Iterator component. 
Type: Table 

Button:   
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8.15 Calibration Blocks Iterator Component 

The Calibration Blocks Iterator component iterates through all calibration blocks of 
the loaded batch. All layout components that are placed inside a Calibration Blocks 
Iterator component will be applied to the calibration block that is iterated. Therefore, 
with one layout several calibration blocks can be printed at a time. 

Type: Iterator 

Button:  
 

8.16 Calibration Curve Component 

The Calibration Curve component prints the calibration curve of the current com-
pound. 
Note: This component will only work within a Compounds Iterator component. 
Note: It is also useful to use a Calibration Blocks Iterator component to iterate 

through the calibration blocks. 
Type: Graphic 

Button:  
 

8.17 Calibration Block Number Component 

The Calibration Block Number component prints the number of the current calibration 
block. 
Note: This component will only work within a Calibration Blocks Iterator component. 

Type: Text 

Button:  
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8.18 Audit Trail Component 

The Audit Trail component prints the audit trail of the loaded batch. The columns to be 
printed are defined via the component's Table columns property.  

Type: Table 

Button:   
 

8.19 Signer Table Component 

The Signer Table component prints detailed signing information. The columns to be 
printed are defined via the component's Table columns property.  

Type: Table 

Button:   
 

8.20 Signer List Component 

The Signer List component prints the names of all signers in succession. It is intended 
for placing signing information into the header or footer. 

Type: Text 

Button:   
 

8.21 Application Name Component 

The Application Name component prints the application name and version number. 
For example, for Bruker Compass applications ‘Bruker Compass’ is placed in front, e.g. 
‘Bruker Compass QuantAnalysis 2.0’. 

Type: Text 

Button:   
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9 FLEXANALYSIS COMPONENTS 

Note: The flexAnalysis components are only available if flexAnalysis is installed on 
your system. 

ReportDesigner provides several flexAnalysis-specific components for printing reports 
with flexAnalysis. The buttons in the flexAnalysis Components toolbar represent the 
following flexAnalysis components. The toolbar is shown when ReportDesigner was 
started without opening a specified layout or when a flexAnalysis layout is active. 
 

  

View  
Spectrum  
Legend  
Mass List  
File Info  
Spectrum Parameter  
Spectrum Parameter Table  
Spectra Iterator  
Analyses Iterator  

Figure 9-1 flexAnalysis Components toolbar 

This User Manual describes the individual flexAnalysis components only with respect to 
their function. Which component properties you can set for a certain component and 
how is described in detail in the ReportDesigner Reference Manual. 

 

9.1 View Component 

The View component prints the current display of the Mass Spectrum window. How 
data should be printed is defined via the component's Properties property. 

Type: Graphic  

Button:   
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9.2 Spectrum Component 

The Spectrum component prints one or more mass spectra. Only spectra that are 
enabled in the Analysis List will be printed. How (a) spectrum/spectra should be printed 
is defined via the component's Properties property. 
Note: Printing does not depend on the current display of the Mass Spectrum window. 
Type: Graphic 

Button:   
 

9.3 Legend Component 

The Legend component prints a legend concerning the mass spectrum/spectra that 
should be displayed by the Spectrum component the Legend component is assigned 
to. 

Type: Graphic 

Button:   
 

9.4 Mass List Component 

The Mass List component prints the Mass List of a mass spectrum, which was found 
by performing the Find Peaks operation. Which columns are to be printed is defined via 
the component's Properties property. The columns either can be taken over from 
flexAnalysis or be defined in ReportDesigner via the component’s Table columns 
property.  

Type: Table 

Button:  
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9.5 File Info Component 

The File Info component prints one element from the file information of an analysis. 
The element to be printed is defined via the component's Selection property. A layout 
can contain several File Info components, each of them printing different file informa-
tion. 

Type: Text 

Button:   
 

9.6 Spectrum Parameter Component 

The Spectrum Parameter component prints one item from the spectrum parameter 
saved with a mass spectrum. The spectrum parameters include acquisition as well as 
processing parameters. The parameter to be printed is defined via the component's 
Selection property. 

Type: Text 

Button:  
 

9.7 Spectrum Parameter Table Component 

The Spectrum Parameter Table component prints a table of spectrum parameters 
saved with a mass spectrum. This table contains the parameter names and corre-
sponding values. The spectrum parameters include acquisition as well as processing 
parameters. Which parameters should be printed is defined via the component's Pro-
perties and Selection properties. 

Type: Table 

Button:   
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9.8 Spectra Iterator Component 

The Spectra Iterator component iterates through all enabled mass spectra. All layout 
components that are placed inside a Spectra Iterator component will be applied to 
each spectrum that is iterated. Therefore, with one layout several spectra can be 
printed at a time.  

Type: Iterator 

Button:  

 

9.9 Analyses Iterator Component 

The Analysis Iterator component iterates through all analyses currently open in 
flexAnalysis. All layout components that are placed inside an Analyses Iterator com-
ponent will be applied to the analysis that is iterated. Therefore, with one layout several 
analyses can be printed at a time. 

Type: Iterator 

Button:   
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10 PROFILEANALYSIS COMPONENTS 

Note: The ProfileAnalysis components are only available if ProfileAnalysis is installed 
on your system. 

ReportDesigner provides in the ProfileAnalysis Components toolbar buttons for the 
following ProfileAnalysis components. The toolbar is shown when ReportDesigner was 
started without opening a specified layout or when a ProfileAnalysis layout is active. 

  

Project Name  
Sample Table  
Models Iterator  
Model Name  
Bucketing Parameter  
Number of PC  
Explained Variances Plot  
Hotelling's T2 Plot  
Influence Plot  
Scores Plot  
Loadings Plot  
Analyses Iterator  
Analysis Name  
Scores Overview Plot  
Excluded Buckets 

 

Figure 10-1 ProfileAnalysis Components toolbar 

This User Manual describes the individual ProfileAnalysis components only with 
respect to their function. Which component properties you can set for a certain compo-
nent and how is described in detail in the ReportDesigner Reference Manual.  
 

10.1 Project Name Component 

The Project Name component prints the name of the current project.  

Type: Text 

Button:   
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10.2 Sample Table Component 

The Sample Table component prints the sample table of the current project. 

Type: Table 

Button:   
 

10.3 Models Iterator Component 

The Models Iterator component iterates through all models of a project. All layout 
components that are placed inside a Models Iterator component will be applied to the 
model that is iterated. Therefore, with one layout several models can be printed at a 
time. 

Type: Iterator 

Button:   
 

10.4 Model Name Component 

The Model Name component prints the name of the current model.  

Note: This component will only work within a Models Iterator component. 

Type: Text 

Button:   
 

10.5 Bucketing Parameter Component 

The Bucketing Table component prints the bucketing parameters of the current 
model. 

Note: This component will only work within a Models Iterator component. 

Type: Table 

Button:   
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10.6 Number of PC Component 

The Number of PC component prints the number of the current PC.  
Note: This component will only work within a Models Iterator component. 

Type: Text 

Button:   
 

10.7 Explained Variances Plot Component 

The Explained Variances Plot component prints the explained variances plot of the 
current model. 
Note: This component will only work within a Models Iterator component. 

Type: Graphic 

Button:   
 

10.8 Hotelling's T2 Plot Component 

The Hotelling's T2 Plot component prints the Hotelling's T2 plot of the current model. 
Note: This component will only work within a Models Iterator component. 

Type: Graphic 

Button:   
 

10.9 Influence Plot Component 

The Influence Plot component prints the influence plot of the current model. 
Note: This component will only work within a Models Iterator component. 

Type: Graphic 

Button:   
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10.10 Scores Plot Component 

The Scores Plot component prints a Scores plot of the current model. The two PCs 
that are plotted against each other are defined via the component's Properties 
property. 
Note: This component will only work within a Models Iterator component. 

Type: Graphic 

Button:   
 

10.11 Loadings Plot Component 

The Loadings Plot component prints a Loadings plot of the current model. The two 
PCs that are plotted against each other are defined via the component's Properties 
property. 
Note: This component will only work within a Models Iterator component. 

Type: Graphic 

Button:   
 

10.12 Analyses Iterator Component 

The Analyses Iterator component iterates through all analyses of a project. All layout 
components that are placed inside an Analyses Iterator component will be applied to 
the analysis that is iterated. Therefore, with one layout several analyses can be printed 
at a time. 
Note: This component will only work within a Models Iterator component. 

Type: Iterator 

Button:   
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10.13 Analysis Name Component 

The Analysis Name component prints the name of the current analysis.  
Note: This component will only work within an Analyses Iterator component. 

Type: Text 

Button:   
 

10.14 Scores Overview Plot Component 

The Scores Overview Plot component prints the scores overview plot of the current 
model. 
Note: This component will only work within a Models Iterator component. 

Type: Graphic 

Button:   
 

10.15 Excluded Buckets Component 

The Excluded Buckets component prints the excluded buckets of the current model. 
Note: This component will only work within a Models Iterator component. 
 
Type: Text 

Button:   
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11 AUDITTRAILVIEWER COMPONENTS 

Note: The AuditTrailViewer components are only available if AuditTrailViewer is 
installed on your system. 

ReportDesigner provides in the AuditTrailViewer Components toolbar buttons for the 
following AuditTrailViewer components. The toolbar is shown when ReportDesigner 
was started without opening a specified layout or when a AuditTrailViewer layout is 
active. 

  

Entires Table  
Record Description  
Filter Description  
Sort Description  
Application Name  

 

Figure 11-1 AuditTrailViewer Components toolbar 

This User Manual describes the individual AuditTrailViewer components only with 
respect to their function. Which component properties you can set for a certain compo-
nent and how is described in detail in the ReportDesigner Reference Manual.  
 

11.1 Entries Table Componen 

The Entries Table component prints the entries of the open audit trail that are currently 
contained in the Entries table. 

Type: Table 

Button:   
 

11.2 Record Description Component 

The Record Description component prints the record description of the open audit 
trail. For an electronic record the corresponding file name and path is given. The 
system and the UserManagement audit trials are indicated by 'System Audit' and 
'UserManagement Audit', respectively. 

Type: Text 

Button:   
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11.3 Filter Description Component 

The Filter Description component prints the description of the filter that is used to filter 
the entries of open audit trail. 

Type: Text 

Button:   
 

11.4 Sort Description Component 

The Sort Description component prints the description of the sort mode that is used to 
sort the entries of open audit trail. 

Type: Text 

Button:   
 

11.5 Application Name Component 

The Application Name component prints the application name and version number. 
Bruker Daltonics applications have the name ‘Bruker Daltonics’ placed in front e.g. 
‘Bruker Daltonics AuditTrailViewer 4.2’. 

Type: Text 

Button:   
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A APPENDIX 

A.1 ReportDesigner 4.5 Basic Toolbars 

The ReportDesigner 4.5 basic toolbars are docked below the menu bar. The following 
table lists all basic toolbars and their buttons with corresponding menu or context menu 
(CM) command (if available), shortcut (if available) and function. 
General actions toolbar 
Button Menu – Command Shortcut Used to ... 

  
File – New Ctrl+N Create a new layout 

  
File – Open  Ctrl+O Open an existing layout.  

  
File – Save  Ctrl+S Save active layout under the same file name. 

  
Edit – Cut Ctrl+X Cut out selected component(s) and put it onto the 

Clipboard. 

  
Edit – Copy Ctrl+C Copy selected component(s) and put it/them onto 

the Clipboard. 

  
Edit – Paste Ctrl+V Insert current Clipboard contents in active layout. 

  
Help – About Bruker 
Daltonics Report 
Designer  

 Display program information, version number and 
copyright. 

  
  Display help for clicked on buttons, menus and 

windows. 
    
Zoom/Pan toolbar 
Button Menu – Command Shortcut Used to ... 

  
  Activate the Zoom mode to zoom the visible 

region of the canvas by a fixed magnification of 
25%. 

 
View – Zoom to Fit  Zoom the visible region of the canvas so that all 

components present are visible. 

 
  Zoom the visible region of the canvas so that all 

currently selected components are visible. 

  
  Activate the Pan mode to pan the canvas. 

    
Drawing toolbar 
Button Menu – Command Shortcut Used to ... 

  
  Activate Select mode to select a component or 

insertion position on the canvas. 

  
  Edit individual vertices of the selected generic line 

component. 
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Edit – Properties  Show and edit properties of the selected 

component. 

  
  Insert a line component in the active layout. 

  
  - not yet implemented - 

  
  - not yet implemented - 

  
  Insert a rectangle component in the active layout. 

  
  - not yet implemented - 

  
  - not yet implemented - 

  
  - not yet implemented - 

  
  Insert a text component in the active layout. 

 
  Insert an image component in the active layout. 

  
  - not yet implemented - 

    
Alignment toolbar 
Button Menu – Command Shortcut Used to ... 

  
  Horizontally align selected component(s) with the 

top border of the anchor component. 

  
  Horizontally align the selected component(s) with 

the middle of the anchor component. 

  
  Horizontally align the selected component(s) with 

the bottom border of the anchor component. 

  
  Vertically align the selected component(s) with the 

left border of the anchor component. 

  
  Vertically align the selected component(s) with the 

center of the anchor component. 

  
  Vertically align the selected component(s) with the 

right border of the anchor component. 
    
Nudge toolbar 
Button Menu – Command Shortcut Used to ... 

  
 ↑ 

(Shift+↑) 
Nudge selected component(s) up by 1 pixel (with 
Shift key hold down by 5 pixels). 

  
 ↓ 

(Shift+↓) 
Nudge selected component(s) down by 1 pixel 
(with Shift key hold down by 5 pixels). 

  
 ← 

(Shift+←) 
Nudge selected component(s) to the left by 1 pixel 
(with Shift key hold down by 5 pixels). 

  
 → 

(Shift+→) 
Nudge selected component(s) to the right by 1 
pixel (with Shift key hold down by 5 pixels). 

 
 

   



Bruker Daltonik GmbH Appendix 

ReportDesigner User Manual, Version 4.5  A-3

Structure toolbar 
Button Menu – Command Shortcut Used to ... 

  
Grouping – Group 
(Component CM) 

 - not yet implemented - 

  
Grouping – Ungroup 
(Component CM) 

 - not yet implemented - 

  
Order – Bring to Front 
(Component CM) 

 Bring selected component(s) to front. 

  
Order – Send to Back 
(Component context 
menu) 

 Send selected component(s) to back. 

  
Order – Bring Forward 
(Component CM) 

 Bring selected component(s) forward. 

  
Order – Send 
Backward (Component 
CM) 

 Send selected component(s) backward. 

    
Layout toolbar 
Button Menu – Command Shortcut Used to ... 

  
  Space selected components horizontally evenly. 

  
  Space selected components vertically evenly. 

  
  Make selected components the same width. 

  
  Make selected components the same height. 

  
  Make selected components the same size. 

    
Canvas toolbar 
Button Menu – Command Shortcut Used to ... 

  
Edit – Undo Ctrl+Z Undo the last action performed on the active 

layout. 

  
Edit – Redo Ctrl+Y Redo the previously undone action performed on 

the active layout. 

  
View – Grid  Show/Hide the grid on the canvas of the active 

layout. 

  
View – Snap to Grid  Activate/Deactivate the Snap to Grid mode for the 

active layout to snap components to the grid. 

  
  - not yet implemented - 

  
  - not yet implemented - 

  
  - not yet implemented - 

For the Common Components toolbar see section 6.2, for the DataAnalysis toolbar 
section 7, for the QuantAnalysis toolbar section 8, for the flexAnalysis toolbar section 9, 
for the ProfileAnalysis section 10 and the AuditTrailViewer toolbar section 11. 



Appendix Bruker Daltonik GmbH 

 ReportDesigner User Manual, Version 4.5 A-4 

A.2 ReportDesigner 4.5 Basic Menus and 
Commands 

The following table lists the ReportDesigner 4.5 basic menus and their commands. In 
addition, application-specific menus may be available depending on the Bruker Dalto-
nics software package(s) currently installed on your system. They will be placed 
between the View and Window menus.  

File menu Commands Used to ... 
New 
Open 
Close 
Save 
 
Save As 
 
Recent File List 
 
Exit 

Create a new layout. 
Open an existing layout. 
Close the active layout. 
Save the active layout under 

the same file name. 
Save the active layout under 

another file name. 
Open a previously processed 

layout. 
Close ReportDesigner.  

Edit menu Commands  Used to ... 

   

Undo 
 
Redo 
 
Cut 
 
 
Copy 
 
Paste 
 
Delete 
 
Components 
 
Properties 
 
Default Properties 
Measurements 

and Size 

Undo last action performed on 
the active layout. 

Redo the action previously 
undone for the active layout. 

Cut the selected component(s) 
and put it/them onto the 
Clipboard. 

Copy the selected compo-
nent(s) to the Clipboard. 

Insert the current Clipboard 
contents in the active layout. 

Delete the selected compo-
nent(s) from the active layout. 

List the current components of 
the active layout. 

Show and edit the properties of 
the selected component. 

Define default properties for 
components to be inserted. 

Define canvas size. 
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View menu Commands  Used to ... 

  

Toolbar 
Status Bar 
Grid 
 
Snap to Grip 
 
 
Angle Snap 
Grid Properties 
 
Zoom Normal 
 
 
Zoom Percent 
 
 
Zoom Custom 
 
 
Zoom to Fit 
 
 

Show/Hide the toolbars. 
Show/Hide the status bar. 
Show/Hide a grid on the canvas 

of the active layout. 
Activate/Deactivate Snap to 

Grid mode for the active 
layout. 

- not yet implemented - 
Define grid properties for the 

active layout. 
Zoom visible canvas region of 

the active layout to normal 
(100%) magnifycation. 

Zoom visible canvas region of 
the active layout by a pre-
defined magnifycation. 

Zoom visible canvas region of 
the active layout by a custom-
defined magnifycation. 

Zoom visible canvas region of 
the active layout so that all 
components present will be 
displayed. 

Window menu Commands  Used to ... 

  

New Window 
 
Cascade 
 
Tile 
 
Arrange Icons 
 
 
 
Open Layout List 

Open a new window for the 
active layout. 

Arrange layout windows so that 
they overlap. 

Arrange layout windows as 
non-overlapping tiles. 

Arrange icons of minimized 
layout windows at the bottom 
of the ReportDesigner 
window. 

Activate selected layout. 
Help menu Commands  Used to ... 

   
(when in Compliance mode) 

Help Topics 
 
Operator 
Lock All 

Applications 
About Compass 

ReportDesigner 

Start ReportDesigner help and 
list help topics. 

Log in specified operator. 
Lock all Bruker Daltonics appli-

cations. 
Show program information, 

version number and copyright. 
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A.3 ReportDesigner 4.5 Context Menus 

ReportDesigner 4.5 provides the following context menus:  

Canvas context menu Commands  Used to ... 

  

Cut 
 
Copy 
 
Paste 
 
Page Bounds 
Grid 
 
Snap to Grid 
 
Angle Snap 
Grid Properties 
 
Zoom 
 
 
 
Default Properties 

Cut the selected component(s) and put 
it/them onto the Clipboard. 

Copy the selected component(s) and put 
it/them onto the Clipboard. 

Insert the current Clipboard contents in the 
active layout. 

- not yet implemented - 
Show/Hide the grid on the canvas of the 

active layout. 
Activate/Deactivate the Snap to Grid mode 

for the active layout. 
- not yet implemented - 
Define the grid properties for the active 

layout. 
Zoom the visible canvas region of the active 

layout by a pre-defined magnification or to 
full display of all components present in the 
active layout. 

Define default properties for components to 
be inserted in the active layout. 

Component context menu Commands Used to ... 

  

Cut 
 
Copy 
 
Paste 
 
Order 
Grouping 
Properties 

Cut the selected component(s) and put 
it/them onto the Clipboard. 

Copy the selected component(s) and put 
it/them onto the Clipboard. 

Insert the current Clipboard contents in the 
active layout. 

Order the selected overlapping components.
Group or ungroup components. 
Show and edit the properties of the selected 

component. 
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A.4 ReportDesigner 4.5 Shortcuts 

ReportDesigner 4.5 provides the following shortcuts:  

Shortcut Menu - Command Used to ... 
Alt+F4 File – Exit  Close ReportDesigner. 
Ctr+Alt+K Help – Lock All 

Applications 
Lock ReportDesigner and other Bruker Daltonics 
applications. 

Ctrl+C Edit – Copy Copy the selected component(s) and put it/them onto the 
Clipboard. 

Ctrl+N File – New Create a new layout. 
Ctrl+O File – Open Open an existing layout. 
Ctrl+S File – Save Save the selected layout under the same file name. 
Ctrl+V Edit – Paste Insert the Clipboard contents in the active layout. 
Ctrl+X Edit – Cut Cut the selected component(s) and put it/them onto the 

Clipboard. 
Ctrl+Y Edit – Redo Redo the previously undone action performed on the active 

layout. 
Ctrl+Z Edit – Undo Undo the last action performed on the active layout. 
Del Edit – Delete Delete the selected component(s). 
F1 Help – Help Topics Start ReportDesigner Help. 
↑  Nudge selected component(s) up by 1 pixel. 
↓  Nudge selected component(s) down by 1 pixel. 
←  Nudge selected component(s) to the left by 1 pixel. 
→  Nudge selected component(s) to the right by 1 pixel. 
Shift+↑  Nudge selected component(s) up by 5 pixels. 
Shift+↓  Nudge selected component(s) down by 5 pixels. 
Shift+←  Nudge selected component(s) to the left by 5 pixels. 
Shift+→  Nudge selected component(s) to the right by 5 pixels. 
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I INDEX 

A 
Acquisition Parameter component 

(DataAnalysis) 7-2 
Acquisition Parameter Table component 
 (DataAnalysis) 7-3 
 (QuantAnalysis) 8-2 
Activating 

Layouts 4-2 
Snap to Gride mode 3-8 

Aligning components 5-11 
Analyses Iterator component 
 (DataAnalysis) 7-4 
 (flexAnalysis) 9-4 
 (ProfileAnalysis) 10-4 
 (QuantAnalysis) 8-3 
Analysis Description component 

(DataAnalysis) 7-2 
Analysis Info component 
 (DataAnalysis) 7-2 
 (QuantAnalysis) 8-4 
Analysis Name component 
 (ProfileAnalysis) 10-5 
 (QuantAnalysis) 8-4 
Application Name component 
 (AuditTrailViewer) 11-2 
 (DataAnalysis) 7-9 
 (QuantAnalysis) 8-7 
Arranging 

Icons of minimized layout windows 3-6 
Layout windows 3-5 

Audit Trail component (QuantAnalysis) 8-7 
AuditTrailViewer components 11-1 
Auto-generated operator groups 2-3 

B 
Basic features of components 5-1 
Basic layout components 6-1 
Batch Info component (QuantAnalysis) 8-2 
Bruker Daltonics UserManagement 2-2 
Bucketing Parameter component 

(ProfileAnalysis) 10-2 
 

C 
Calibration Block Number component 

(QuantAnalysis) 8-6 
Calibration Blocks Iterator component 

(QuantAnalysis) 8-6 
Calibration Curve component 

(QuantAnalysis) 8-6 
Calibration Info component 
 (DataAnalysis) 7-8 
Canvas 

Hiding grid 3-7 
Setting grid properties 3-8 
Setting up 3-6 
Showing grid 3-7 
Sizing 3-7 
Zooming 3-9 

Changing 
Password of operator 2-6 

 z-order of components 5-12 
Checking layouts 5-17 
Chromatogram component 
 (DataAnalysis) 7-5 
 (QuantAnalysis) 8-4 
Chromatograms Iterator component 

(DataAnalysis) 7-5 
Closing 

Layouts 4-4 
ReportDesigner 2-8 

Common Components 6-2 
Compliance mode 2-1 
Components 

Aligning 5-11 
AuditTrailViewer 11-1 
Basic 6-1 
Basic features 5-1 
Basic types 5-1 
Changing z-order 5-12 
Common 6-2 
Copying 5-7 
Cutting out 5-7 
DataAnalysis 7-1 
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Deleting 5-8 
Editing properties 5-5 
Enlarging 5-8 
flexAnalysis 9-1 
Generic 6-1 
Grouping 5-13 
Handling 5-6 
Inserting 5-1, 5-5 
Making same size 5-9 
Moving 5-10 
Nudging 5-11 
Pasting 5-8 
Placing 5-10 
ProfileAnalysis 10-1 
Properties 5-2 
QuantAnalysis 8-1 
Reducing 5-8 
Resizing 5-8 
Selecting 5-6 
Setting default properties for  
 inserting 5-4 
Spacing 5-13 
Ungrouping 5-13 

Compound List component 
 (DataAnalysis) 7-6 
 (QuantAnalysis) 8-5 
Compound Name component 
 (DataAnalysis) 7-6 
 (QuantAnalysis) 8-5 
Compounds Iterator component 
 (DataAnalysis) 7-5 
 (QuantAnalysis) 8-5 
Context menus A-6 
Copying components 5-7 
Creating layouts 4-1 
Customizing user interface 3-2 
Cutting out components 5-7 

D 
DataAnalysis components 7-1 
Deactivating Snap to Grid mode 3-8 
Deconvolution Results component 

(DataAnalysis) 7-8 
Defining 

Canvas size 3-7 
Component order 5-12 
Component properties 5-5 

 

Deleting components 5-7, 5-8 
Display component (DataAnalysis) 7-4 
Docking toolbars 3-3 

E 
Editing 

Component properties 5-5 
Layouts 5-1 

Enlarging components 5-8 
Entries Table component  
 (AuditTrailViewer) 11-1 
Excluded Buckets component 

(ProfileAnalysis) 10-5 
Explained Variances Plot component 

(ProfileAnalysis) 10-3 

F 
File Info component (flexAnalysis) 9-3 
Filter Description component 

(AuditTrailViewer) 11-2 
flexAnalysis components 9-1 

G 
Generic components 6-1 
Grid 

Setting properties 3-8 
Grouping components 5-13 

H 
Handling components 5-6 
Hiding 

Grid 3-7 
Status bar 3-2 
Toolbars 3-3 

Hotelling's T2 Plot component 
(ProfileAnalysis) 10-3 

I 
Image component 6-2 
Influence Plot component  
 (ProfileAnalysis) 10-3 
Inserting components 5-1, 5-5 
Installing ReportDesigner 2-1 
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L 
Layout windows 

Arranging 3-5 
Arranging icons 3-6 
Manipulating 3-4 
Minimizing 3-6 
Moving 3-4 
Resizing 3-5 

Layouts 
Activating 4-2 
Checking 5-17 
Closing 4-4 
Creating 4-1 
Editing 5-1 
Opening 4-2 
Printing 5-17 
Saving 4-3 
Selecting 4-2 
Tips on how to edit 5-14 

LC Acquisition Parameter component 
 (DataAnalysis) 7-3 
 (QuantAnalysis) 8-2 
Legend component (flexAnalysis) 9-2 
Line component 6-2 
Loadings Plot component  
 (ProfileAnalysis) 10-4 
Locking 

Bruker Daltonics applications 2-7 
Operator 2-5, 2-7 
ReportDesigner 2-7 

Logging in operator 2-5 

M 
Making components the same size 5-9 
Manipulating 

Canvas 3-6 
Layout windows 3-4 
Toolbars 3-3 

Mass List component 
 (DataAnalysis) 7-7 
 (flexAnalysis) 9-2 
Menus A-4 
Method Parameter component 

(QuantAnalysis) 8-3 
Method Part component (DataAnalysis) 7-4 
Method Table component  
 (QuantAnalysis) 8-3 

Minimizing layout windows 3-6 
Model Name component  
 (ProfileAnalysis) 10-2 
Models Iterator component  
 (ProfileAnalysis) 10-2 
Moving 

Components 5-10 
Layout windows 3-4 
Toolbars 3-4 

N 
Non-Compliance mode 2-1 
Nudging components 5-11 
Number of PC component  
 (ProfileAnalysis) 10-3 

O 
Opening layouts 4-2 
Operator 

Changing password 2-6 
Locking 2-5, 2-7 
Logging in 2-5 
Rights in ReportDesigner 2-3 
Unlocking 2-7 

Operator rights in ReportDesigner 2-3 
Ordering overlapping components 5-12 

P 
Page Break component 6-4 
Page Footer component 6-3 
Page Header component 6-3 
Page Number component 6-3 
Pasting components 5-8 
Placing components 5-10 
Print Date and Time component 6-4 
Print Date component 6-4 
Print Time component 6-4 
Printing layouts 5-17 
ProfileAnalysis components 10-1 
Project Name component  
 (ProfileAnalysis) 10-1 

Q 
QuantAnalysis components 8-1 
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R 
Rectangle component 6-1 
Reducing components 5-8 
Reocrd Description component 

(AuditTrailViewer) 11-1 
ReportDesigner 

Auto-generated operator groups 2-3 
Closing 2-8 
Compliance mode 2-1 
Context menus A-6 
Installing 2-1 
Logging in operator 2-5 
Menus A-4 
Non-Compliance 2-1 
Rights in UserManagement 2-3 
Shortcuts A-7 
Starting 2-4 
Toolbars A-1 
Uninstalling 2-1 
User interface 3-1 
UserManagement 2-2 

Resizing 
Components 5-8 
Layout windows 3-5 

S 
Sample Info component (DataAnalysis) 7-3 
Sample Table component  
 (ProfileAnalysis) 10-2 
Saving layouts 4-3 
Scores Overview Plot component 

(ProfileAnalysis) 10-5 
Scores Plot component  
 (ProfileAnalysis) 10-4 
Scripting Table component  
 (DataAnalysis) 7-8 
Scripting Variable component 

(DataAnalysis) 7-9 
Selecting 

Components 5-6 
Layouts 4-2 

Setting default properties for inserting 
components 5-4 

Setting up 
Canvas 3-6 
Grid 3-8 

Shortcuts A-7 

Showing 
Grid 3-7 
Status bar 3-2 
Toolbars 3-3 

Signer List component 
 (DataAnalysis) 7-9 
 (QuantAnalysis) 8-7 
Signer Table component 
 (DataAnalysis) 7-9 
 (QuantAnalysis) 8-7 
Sizing 

Canvas 3-7 
Components 5-8 
Layout windows 3-5 

SmartFormula Table component 
(DataAnalysis) 7-8 

Sort Description component 
(AuditTrailViewer) 11-2 

Spacing components 5-13 
Spectra Iterator component  
 (DataAnalysis) 7-6 
 (flexAnalysis) 9-4 
Spectrum component 
 (DataAnalysis) 7-7 
 (flexAnalysis) 9-2 
 (QuantAnalysis) 8-5 
Spectrum Parameter component 

(flexAnalysis) 9-3 
Spectrum Parameter Table component 

(flexAnalysis) 9-3 
Starting ReportDesigner 2-4 
Status bar 

Hiding 3-2 
Showing 3-2 

Survey View component (DataAnalysis) 7-4 

T 
Text component 6-2 
Tips and guidelines on how to edit  
 layouts 5-14 
Toolbars A-1 

Docking 3-3 
Hiding 3-3 
Manipulating 3-3 
Moving 3-4 
Showing 3-3 
Undocking 3-3 
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U 
Undocking toolbars 3-3 
Ungrouping components 5-13 
Uninstalling ReportDesigner 2-1 
Unlocking 

Bruker Daltonics applications 2-7 
Operator 2-7 
ReportDesigner 2-7 

User interface 
Customizing 3-2 
Description 3-1 

UserManagement 2-2 

V 
View component (flexAnalysis) 9-1 

W 
Work List Iterator component 

(DataAnalysis) 7-7 
Work Table component (QuantAnalysis) 8-3 

Z 
Zooming canvas 3-9 
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